
 

Movavi Screen Capture Studio 9
 

Don't know where to start?
Read these tutorials:

Recording screen
Capture any fragment of your

screen or the full desktop.

Recording online video
Record video from online video

websites such as YouTube or Vimeo.

Recording video from players
Record any video in your player.

Recording Skype calls
Record Skype calls with sound from both ends.

Recording only audio
Record any sound from a device

or music on your computer.

Need more help?
Write to us at support@movavi.com

Or click here to open live chat.
 

mailto:support@movavi.com
https://chatserver.comm100.com/ChatWindow.aspx?planId=1190&visitType=1&byHref=1&partnerId=-1&siteid=27345
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Activating Screen Capture Studio
Step 1: Click the button below to buy an activation key. After the purchase is completed, the key will be delivered to you via e-mail.

Step 2: On the launcher window, click the Activate button.

Step 3: Enter your activation key and click Activate.

https://www.movavi.com/screen-capture/buynow.html?asrc=scs_help
https://www.movavi.com/screen-capture/buynow.html?asrc=scs_help
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Activating without Internet access
If your computer is not connected to the Internet, you can activate Movavi Screen Capture Studio via e-mail.
 
Step 1: Click the button below to buy an activation key. After the purchase is completed, the key will be delivered to you via e-mail.

Step 2: On the launcher window, click the Activate button.

Step 3: Enter your activation key and select the Activate offline option. Then, click Activate.

Step 4: In the next window, click Copy and transfer this information to a computer or device with an Internet connection.

Step 5: When you have access to the Internet, paste the information you copied into a new e-mail and send it to reg@movavi.com. You should receive a
reply within an hour. Copy the registration key from the reply and transfer it to the computer with Movavi Screen Capture Studio.

https://www.movavi.com/screen-capture/buynow.html?asrc=scs_help
https://www.movavi.com/screen-capture/buynow.html?asrc=scs_help
mailto:reg@movavi.com


 

6

Step 6: Return to the window with offline activation. If you've closed the window, repeat steps 1-3 and enter the same activation key you used before.
Then, paste the registration key into the box and click Activate.
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Getting an activation key
To activate Movavi Screen Capture Studio, you will need an activation key. You can buy an activation key from our official website or from any of our
partners, and it will be delivered to you via e-mail.
 
1. On the Movavi Screen Capture Studio launcher, click the cogwheel button and choose Buy Activation Key from the menu, or use the button below.

2. On the purchase page, click the Buy Now button next to the type of license that you need.
•  If you're a home user, choose the Personal License.
•  If you're planning to use Movavi Screen Capture Studio for work, business, or government organizations, choose the Business License.
 
3. Fill in your billing information and enter a valid e-mail address. IMPORTANT! We will send the activation key to this e-mail address, so please make
sure it is entered correctly.
 
4. After you've completed your payment and your request has been processed, you will receive a confirmation e-mail from support@movavi.com with your
activation key.

If you haven't received your activation key:
•  Check the Spam folder of your mailbox
•  Contact support

https://www.movavi.com/screen-capture/buynow.html?asrc=scs_help
https://www.movavi.com/screen-capture/buynow.html?asrc=scs_help
http://www.movavi.com/support/contact.html
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Trial limitations
When you first start your copy of Movavi Screen Capture Studio, it will be running in LIMITED TRIAL MODE until you activate the program. You can
use all the features, but the following restrictions will apply:
TRIAL VERSION FULL VERSION

 Movavi Screen Capture Studio will stop working after 7 days  Lifetime license

 A watermark with the words ' trial version' will be added to all exported
videos

 No annoying watermarks

 Capture time is limited to 2 minutes per video  Unlimited capture time

 Audio files will only be saved halfway in Movavi Video Editor  Free updates

  Discounts on other Movavi products and upgrades
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Recording video from screen
How to make a screencast with Movavi Screen Capture Studio

 
This tutorial will show you how to record and save a video from what's happening on your screen.
 
Step 1: Set up the capture area
1. On the Movavi Screen Capture Studio launcher, click Record screen.

2. On the recording panel, click the Select capture area button.
3. Select the part of the screen that you want to record:
•  Click and drag on the screen to select the capture area.
•  To record a window or a window panel, hover your mouse pointer over it and click once a frame appears around it.
•  To record the full screen, click on any empty space.

Step 2: Set up the sound
Recording system audio
1. Click the System Audio button to enable recording sounds and audio playing on your computer.
2. Use the slider on the left to set the necessary recording volume.

 
Recording from a microphone
1. Make sure that a microphone is connected to your computer.
2. Click the Microphone button to enable recording sounds from external devices.
3. Click the arrow above the Microphone button and select the device you want to use for recording.

 
Step 3: Start recording
When you're ready to begin, click the REC button. You will be given a 3-second countdown before the recording begins.

Use these keyboard shortcuts to control the recording process:
F9 - pause the recording
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F8 - take a snapshot of the capture area
F10 - end capture and save the recording
Tip: these are the default hotkeys. You can change them in the Keyboard Shortcuts section of the preferences.

 
When you're ready to finish your recording, click Stop on the recording panel or use the F10 keyboard shortcut .
 
Step 4: Edit the recording (optional)
When you finish recording, the capture  editing window will open. Your video is ready and saved in MKV format, but you can preview it, edit, or save it in
a different format.
 
Cutting the recording
To cut out a fragment:
1. Place the position marker to the beginning of the unwanted fragment and click the scissors icon.
2. Move the position marker to the end of the fragment and click the scissors button again.
3. Move the position marker to the center of the fragment to select it and click the trash can button.

Saving the edited recording
To save the trimmed version, or to change the format of your recording:
1. Click the Save As button. The output options will open.
2. Click one of the squares at the top to choose a format for saving your video.
3. Choose a name and location for saving the video.
4. Click Save to start processing your recording.
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Frequently asked questions
I get a codec activation message when I try to start recording
When you first start using Movavi Screen Capture Studio, you need to activate the codecs you are using. Simply click Activate in the message box to start
using these codecs and continue with your capture. This process is free of charge and does not collect any personal information.
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Recording online video
How to download videos from YouTube, Vimeo, and other websites

Step 1: Select capture area
1. On the Movavi Screen Capture Studio launcher, click Record screen.

2. On the recording panel, click the Select capture area button.
3. The screen will dim and a magnifying glass will appear.
•  For high-quality videos, we recommend recording in full screen mode. To select the entire screen, click on any empty area of the desktop.
•  For low-quality videos, draw the capture area on top of the web player. 

Step 2: Enable system sound
The recording panel will appear. Here, you can set up the sound and other options.
1. Click the System Audio button to enable sound recording.
2. Use the slider to the left to set the necessary system audio volume.

Step 3: Record the video
1. To ensure the best recording quality, set the online video player to the highest quality and wait for the video to load.
2. Click the REC button to begin recording.

3. You will be given a 3-second countdown before recording starts. Use this time to enable full screen mode and click Play to start the video.
4. When the video ends, use the F10 keyboard shortcut to finish recording, or click Stop on the recording panel.

 
Step 4: Cut and convert the video (optional)
Your video is now ready. When you end the recording, you can play the finished video, cut out unwanted parts, or save it in a different format.
 
Trimming the video
If you've recorded extra bits at the beginning or at the end of the video:
1. Place the position marker to where you want to cut the video.
2. Click the scissors button to cut at the selected time.
3. Select the fragment you've cut and click the trash can icon to delete it.
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Saving the edited video
After you finish capture, your recording is already saved in MKV format. If you've cut the video or want to change the format, you will need to save a
copy of the video.
1. Click the Save As button in the editing window. The output options will appear.
2. At the top, choose the format for saving the new video.

3. Name your file and click the button in the Save to  box to choose where to save the video.
4. Click Save to begin processing your recording. 
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Recording with webcam
How to add a simultaneous webcam overlay to your videos

Step 1: Select capture area
1. In the Movavi Screen Capture Studio launcher, click Record screen.

1. On the recording panel, click the Select capture area button.
2. With the crosshair, select the part of the screen that you want to record.

 
Step 2: Set up the webcam
1. Connect the webcam to your computer and wait until the system installs the necessary drivers.
2. Click the cogwheel icon on top of the Webcam button. The webcam preferences will open.

3. Under Use this webcam, choose the webcam device that you want to use and check that its preview appears on the right.
 
4. Set up the video options for this webcam:
 
•  Click the Settings button to set up your webcam's options such as brightness, contrast, and exposure. Note: webcam settings are different for each model.
 
•  Choose the resolution that you would like to use. The higher the resolution, the higher the webcam video quality will be. However, if the webcam video
is small, you may not need a very large resolution.
 
•  For the best quality, use the highest frame rate that your webcam can provide for the best quality. If your webcam is mostly static or if you want a
smaller file size, you may want to use a lower frame rate.
 
5. Set up the size and position for your webcam:
 
•  Use the Video size slider to set the size of the webcam picture relative to the entire video.
 
•  Choose one of the Position options to place your webcam picture inside the frame.
 
6. Click OK to save the webcam preferences.
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Now that you've set up the webcam, the next time you want to use it, simply click the Webcam button once to enable webcam recording.
 
Step 3:  Set up sound
Next, choose the audio sources that you want to hear on your recording:
 
System sounds
To record music and other sounds playing on your computer, click the System Audio button. The button appears green when enabled.
 
Microphone
You can record audio from your webcam's built-in microphone, or use an external microphone for better sound quality:
1. Click the Microphone button to enable recording from external devices.
2. Click the arrow above and choose the microphone you want to use from the list.

Step 4: Record your video
When you're ready to begin, click REC to start recording. The recording panel will be minimized during recording.

0
To finish the recording, press F10 or click Stop on the recording panel.
 
Step 5: Edit and save
When the recording is finished, it will open in the capture editor, where you can play or trim the result.



 

16

To cut or trim the video, use the scissors and trash can buttons on the toolbar. If you've trimmed the file or if you want to save your recording in a
different format, click Save As.
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Recording video from players
Before you start:
Note the quality and resolution of your video. For best video quality, it is recommended that you record the video as close to its real resolution as possible.
•  If the video is larger than your screen, maximize the player window and record the full screen.
•  If the video is smaller than your screen, set the player settings to display the actual size. In this case, stretching the video to the full screen will decrease
the quality.
 
Step 1: Choose the capture area
1. On the Movavi Screen Capture Studio launcher window, click Record screen.

2. On the recording panel, click the Select capture area button.
3. With the crosshair, select the part of the screen that you want to record.

Step 2: Set up the sound
After you've selected the capture area, the recording panel will appear. Use the panel to set up the recording options.
 
1. To enable recording sounds from the player, click the speaker button under System Audio. The button will appear green when enabled.
2. Use the slider to the left of the speaker button to set the volume of the player's recording.
3. To make sure that  other sounds don't interfere with your recording, check that the Microphone button is disabled (black), and close other windows or
browser tabs that might play sounds during your recording.

Step 3: Record video
When you're ready, click the REC button on the recording panel and start playback in the player. The recording panel will hide
Tip: You can trim the beginning later, so don't worry if you start playback after recording has begun.



 

18

To end the recording, press F10 or click Stop on the recording panel.
 
Step 4: Edit and convert (optional)
Your recording is ready and saved in MKV format, and you can view the result in the capture editor. Now, you can trim the video or convert it to a
different format.
 
1. To trim the video from the beginning or from the end, move the position marker to where you want to trim the video and click the scissors button to cut
off the fragment. Then, select the unwanted fragment and click the trash can button to delete the fragment.

2. Click the Save As button to open output options.
 
3. At the top of the window, select the format you want to save the recording in.
 
4. Under File name, enter a name for the new video. Then, click the button under Save to and choose where you want to save the video.
 
5. Click Save to start processing the new file.
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Troubleshooting
Some video player programs have video output settings that prevent capturing video and taking screenshots. If you are having trouble recording video from
any of the following players, follow the steps to change the player's settings and enable video capturing.
 
Capturing video from VLC (VideoLan Media Player)
(for Windows XP users)
1. In VLC player, open the Tools menu and choose Preferences.
2. Switch to the Video tab (in Simple mode)
3. In the Display section, find the Output list. If DirectX (DirectDraw) video output is selected, try using a different output mode.
 
Capturing video from Media Player Classic
(for Windows XP users)
1. In Media Player Classic, open the View menu and select Options.
2. Go to the Playback > Output section in the tree on the left.
3. Find the DirectShow Video option. Here, you can choose from a list of video renderers that will affect how the player displays video on your screen. If
the Overlay Mixer Renderer is selected, select any other renderer from this list.
4. Click OK to accept the changes.
 
Capturing video from Windows Media Player
(for Windows XP users)
1. In the main player menu, open the Tools menu and select Options.
2. In the Options window, switch to the Performance tab.
3. Click the Advanced button.
4. In the Video Acceleration section, find the Use overlays option and deselect it.
5. Click OK to accept the changes.
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Recording Skype calls
When you record audio or video calls using Skype™ or a similar program, it is important that you record both ends of the conversation. To do that, you
will need to record input from your microphone or webcam, as well as the audio from your speakers. Follow the steps below to record Skype calls with
audio.
 
Step 1: Select capture area
1. Launch the Skype application and make sure it is on screen.
2. On the Movavi Screen Capture Studio launcher, click Record screen.

3. On the recording panel, click the Select capture area button.
4. Your cursor will turn into a crosshair. Draw a rectangle inside the Skype window where your call video will be.

Step 2:  Set up the sound
Once the capture area is selected, the recording panel will appear. Here, you can choose which sound sources can be heard on your recording.
1. Click the speaker button under System Audio to enable recording sounds on your computer, including the call from the other end.  The button appears
green when enabled.
2. Click the Microphone button to enable recording from a microphone. If you have more than one microphone, click Microphone and choose the one
you want to use for the recording.
3. Use the sliders to the left of each button to set the necessary volume levels for the call and for your microphone.

Tip: if you're recording a video call, you do not need to enable webcam recording in Movavi Screen Capture Studio, because Skype is already recording
your webcam.
 
Step 3: Record your call
1. Start your call in the Skype window.
2. Click REC on the Movavi Screen Capture Studio panel to begin recording.
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3. When you finish your call, press F10 or click the Stop button on the recording panel to finish recording. The capture editor will appear, where you can
play the finished video, cut the recording, or save it in a different format.

Step 4: Edit and convert (optional)
If your recording started before the call, you can trim off the extra bits using the scissors and trash can buttons.
 
1. Place the position marker to where you want the video to start and click the scissors button.
 
2. Select the unwanted fragment and click the trash can button to delete it.

3. Now that you've cut the video, you need to save the trimmed copy. To do that, click the Save As button.
 
4. The export options will open in a new window. There, select the format you want to use, name the file and choose where you want to save it, and click
Save to start processing the video.
Tip: If you want to save just the audio of the call without the video, select MP3.
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Making an animated GIF
To create a GIF, all you need to do is record an action or video on the screen and then save the animation in the GIF format.
 
Step 1: Select capture area
1. Click Record screen on the launcher window.

2. Click the Select capture area button on the recording panel. Your cursor will turn into a crosshair.
3. Draw a rectangle with your mouse to select the area that you want to record.

If you need to adjust the capture area, drag its edges to change the size and drag the square  in the center to change its position.
 
Step 2: Record the action
Once everything is ready, click the orange REC button to begin recording your GIF.

When you've finished your recording, press F10 or click Stop on the control panel. Don't worry if you accidentally record more than you need, you can
trim the recording later.
 
Step 3: Trim and save your GIF
After capture is complete, you will see your recording in the capture editor window.
 
Trimming the GIF (optional)
If you've recorded extra bits, you can cut them off:
1. Place the position marker to where you want to cut the video.
2. Click the scissors button to make a cut.
3. Select the fragment you want to remove and click the trash can button.
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Saving the GIF
1. Click the Save As button to open output options.
2. Click the GIF square at the top to choose GIF as the output format.
Advanced: If you need to edit the size and quality of the GIF, click the cogwheel button next to Output format.
3. Name your GIF file and choose where you want to store it.
4. Click Save to start turning the recording into an animated GIF.

Fun fact!
The creators of this format intended it to be pronounced as 'jif', but it is now more

common to pronounce it with a hard 'g', so both pronunciations are accepted.
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Record audio only
Recording music or voice with Movavi Screen Capture Studio

Besides screen activity, you can just as easily record online music, radio, podcasts, and voice input as standalone audio files.
 
Step 1: Open the recording panel
In the launcher window, click Record screen. On the recording panel, choose which audio sources you want to record from:

Step 2: Set up the audio
Recording system sounds
To record music, online videos, and any other sounds playing on your computer, click the System Audio button.

off                on
 

Recording microphone audio
To record sound from a microphone or any other recording device connected to your computer, click the Microphone button. If you have more than one
recording device, click the arrow above the button and select the device you want to record from.

off               on
Volume levels
Use the sliders to the left of the System Audio and Microphone buttons to adjust the volume of each source.

 
Step 3: Record the audio
Click REC when you're ready to begin recording.

To end the recording, press F10 or click Stop on the recording panel.
 
Step 4: Save audio file
When the recording is finished, the capture editor window will appear, where you can play the audio you've recorded.
 
1. Click Save As to open the exporting options.
 
2. To save just the audio from your recording, click the MP3 button at the top.
 
3. Click Save to turn your recording into an audio file.
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Troubleshooting audio
If you don't see the device you want to use in the list, it may be disconnected or disabled in system settings.
1. Right-click the sound icon in the Windows notification area and choose Recording Devices from the pop-up menu. The Sound settings window will
open.
2. In the Recording Devices window, look for the necessary device in the list. If it is detected and enabled in your system, there should be a green
checkmark beside it.
3. If you cannot find the device in the list, right-click anywhere in the list and make sure that the options Show Disabled Devices and Show Disconnected
Devices are selected.
4. If the device is listed as Not Plugged In, try plugging in the device again.
5. If the device is listed as Disabled, right-click the device and choose Enable.
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Setting up a screen recording
To start preparing for a screen recording, click Record screen on the launcher window:

Recording panel
You can use the recording panel to set up your recording.

Learn more: Capture area
 
Sound
You can record sound from two different sources on your video: from your speakers, or from an external device, such as a microphone.
•  Click the speaker button to record system audio,
•  Click the microphone button to record from a microphone.
Learn more: Sound
 
Webcam
You can simultaneously record your webcam footage that will show up in the corner of the video. Connect the camera and click the Webcam button on the
recording panel.
Learn more: Webcam

 
 
Cursor recording
If you're making an instructional video, you can highlight the cursor and its clicks to help your viewers keep track of your mouse. You can change the
appearance of your cursor in the Effects section of the Preferences.
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Learn more: Mouse cursor effects

Keystroke recording
If you're showing keyboard actions such as hotkeys on your video, you can enable keystroke recording, and the keys you press will automatically appear at
the bottom of the video. You can enable keystroke recording in the Effects section of the Preferences.
Learn more: Recording keystrokes
 
Scheduling recordings
When you've finished setting up your recording, you can start it right away or schedule it to begin or end automatically. You can schedule your recordings
in the Capture Time section of the Preferences.
 
Starting the recording
To start recording right away, click the REC button on the recording panel. You can pause and end capture using the buttons on the recording panel: 
Learn more: Starting the recording
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Capture area
The orange frame defines which part of your screen will be visible in your screen recording.
 
Selecting the capture area
Step 1: Click the Select Capture Area button on the recording panel.

Step 2: Your cursor will turn into a crosshair. Use it to select the part of the screen that you want to record.
 
•  To record a window or a window panel, hold your mouse pointer over the window you want to record and click when a frame appears around it.
Tip:  if you select a window, the capture area will follow whenever you move the window.
 
•  To record the entire screen, click on an empty part of the desktop.
 
•  To record a part of the screen, click and drag diagonally to draw the area where you want it to appear.

Setting an exact size
After you've opened the recording panel, you can choose a preset size from the Capture Area section, or enter an exact size into the boxes:

To set the capture area to full screen, open the preset list and choose DISPLAY from the list.
 
Editing the capture area
•  To change the capture area size, drag the edge of the capture area with your mouse.
 

•  To move the capture area, drag the square  in its center.
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Sound
You can record sound from two separate sources: system audio and microphone audio. You can enable sound recording on the recording panel.

System audio
System audio is the sound that you can hear from your speakers. It includes music, video sound, alerts, and all other sounds.
 
1. To enable recording system audio, click the speaker icon on the recording panel. 

2. Use the slider to the left of the speaker button to change the system audio volume. This will also affect the volume that you hear. 
 
Microphone audio
To record from a microphone or any other external recording device:
 
1. Connect the microphone to the computer. Make sure that it is recognized by the system and working correctly.
 
2. Click the microphone icon on the recording panel to enable microphone recording.
 
3. If you have more than one recording device connected, click the arrow  next to Microphone and choose which microphone you want to use.
 
4. Use the slider to the left of the microphone button to change the volume.

 
 
When enabled, the sound icons appear green. 

off            on
 
 

Troubleshooting
Capturing system sound on Windows XP
Windows XP does not support recording from multiple audio sources. You can either record microphone audio or system audio, but not both. To record
system sound on Windows XP:
1. Click the microphone button to enable recording from audio devices.
2. Click the triangle next to Microphone and choose Stereo Mix from the list of devices.
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Please note that not all hardware allows stereo mix recording. 
 
See also:
Recording only audio
Recording Skype calls
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Webcam
You can record webcam video simultaneously with a screencast. The webcam video will appear in the corner of the main video.
 
Enable the webcam
To enable webcam recording, click the webcam icon on the recording panel:  

Webcam options
If this is your first time recording with a webcam, you may want to set up how the webcam looks on your video. To open the webcam options, click the
cogwheel icon on the webcam button.
Or open the Settings menu, choose Preferences, and then switch to the the Webcam tab.

If you have more than one camera, choose the one you want to use under "Use this webcam".
 
Webcam properties
Click the Settings button to open your webcam's built-in properties. These can be different for each manufacturer, but usually you can set up the
brightness, white balance, exposure, and other color options.
 
Resolution
The resolution affects the quality of the output video. If the video is very small, you can choose a lower resolution without a noticeable decrease in quality.
 
Frame rate
Frame rate is the number of shots the camera takes each second. Higher frame rates will make the movements look smoother and work best for videos with
a lot of motion. If the picture is mostly static, you can decrease frame rate to save disk space. The standard frame rate is 20-30 frames per second.
 
 
Video size
Use the video size slider to change the size of the webcam video relative to the main video.
 
Position
You can place your webcam footage in any of the four corners of the main video. Choose where to place the webcam video under position.
 
See also: Webcam preferences
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Mouse cursor effects
Using mouse effects, you can use the mouse as a pointer and show your viewers where to click.
 
Step 1: Open the mouse cursor options
1. Click the Settings menu and choose Preferences.
2. In the Preferences window, switch to the Effects tab.
Learn more: Effects options

Step 2: Enable the cursor
Select Show cursor on recording. This will make the cursor visible on recordings. To make the cursor invisible, disable this option.

Step 3: Highlight cursor actions (optional) 
To make the cursor visible even better, you can highlight it or enable a special effect for clicks.
 
Highlight cursor
A semi-transparent circle will appear around the cursor, making it easier to track.

1. Select the Highlight cursor option.
 
2. (optional) The default highlight is yellow. To change the highlight color, click the square on the right and pick the new color.
 
3. (optional) Use the Size slider to make the highlight smaller or larger. The cursor itself will remain the standard size.
 
Hover your mouse over the square on the right to preview the highlight.
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Highlight clicks
Concentric circles will appear for every click, color-coded for two mouse buttons. 

1. Select the Highlight clicks option.
 
2. (optional) Click the left square to set the color for the left mouse button.
 
3. (optional) Click the right square to set the color for the right mouse button.

Mouse click sound
A clicking sound will play whenever you click the mouse.
 
1. Enable the Mouse click sound option.
 
2. (optional) The default clicking sound has already been selected for you. If you want to use your own sound, open the drop-down box and choose Add
sound. Then, open the sound file that you want to use.
You can use WAV, MP3, AIFF, and AU files.
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Recording keystrokes
If you're making a tutorial that uses keyboard shortcuts, it's helpful to display them on screen for your viewers. Enable keystroke recording to show the
keys you pressed at the bottom of the video.
 
1. Open the Settings menu.
 
2. Choose Preferences.
 
3. In the Preferences window, switch to the Effects tab.
 
4. To enable keystroke recording, select one of the options:

•  Keyboard shortcuts only — only key combinations such as Ctrl+C or Shift+Control+Esc will show up on screen. Letters and keys that do not
cause an action will not be displayed. 
•  All keystrokes — each key you press will appear on screen, including letters and numbers.

To turn off keystroke recording, open the Effects preferences once again and disable the keystroke recording options. 

Tips:
•  Avoid entering any passwords or other sensitive information while you're recording a video with keystroke recording: if you share the video, your
viewers will be able to see each character you type.
•  Keyboard shortcut recording does not work with the Windows key.
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Scheduling
Any recording can be scheduled for a later time. You can use this to automate your recordings or capture late-night webinars.
 
Step 1: Set up your recording 
Scheduled recordings will start with the currently selected capture area, sound, and other options. Before scheduling the recording:
 
1. Click the Select Capture Area button on the recording panel and select the part of the screen you want to see on your scheduled recording.
 
2. To enable system sound recording, click the speaker button on the recording panel and make sure it is enabled and highlighted green.

Learn more: Capture area | Sound | Webcam
 
Step 2: Schedule recording

1. On the recording panel, click the alarm clock button  to open capture time settings.
Or open the Settings menu, choose Preferences and switch to the Capture Time tab.

2. Under "Capture time options" select Start and end on schedule.
 
3. Next to Start time, enter the time and date when you want to start the recording.
 
4. Next to End after, enter the length of the recording.

The recording is now set to automatically start and end at the given time.
 
Step 3: Schedule sleep or shut down (optional)
After a scheduled recording, you can set your computer to automatically sleep or shut down to conserve energy.
 
1. In the Capture Time preferences, open the After capture box.
 
2. Select Sleep or Shut down.
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Step 4: Enable launching at startup (optional)
The screen recorder needs to be running at the scheduled start time to begin the recording. If you've scheduled the recording for a later date, enable the
program to start with your computer so that you don't miss the recording. To do that, open the General section of the Preferences and enable the Launch
application at startup option.

Finally, click OK in the Preferences window to save the changes. After the recording is finished, the recording file will be stored in *.mkv format in the
output folder with your other screen recordings.

Please note that if you haven't yet activated the program, the maximum capture time is two minutes for each video. To learn more about activating Movavi
Screen Capture Studio, see the Activating Software section.
 
If you are starting a lengthy recording, make sure that you have enough free disk space for saving the temporary recording files.
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Time limit
When you record a long webinar or online video, you can limit the recording to a specific time and it will stop automatically once the time is up. This way,
you don't have to wait around for the video to end.
 
Step 1: Set a time limit

1. On the recording panel, click the alarm clock button  to open capture time settings.
Or open the Settings menu, choose Preferences and switch to the Capture Time tab.

 
2. Select the Start manually and end after option.
 
3. On the right, enter the time limit as hours:minutes:seconds.
 
4. Click OK to enable the time limit.
Note: the limit will work on all your next recordings in the current session only, until you restart the program.

 
Step 2: Start the recording
Click the REC button on the recording panel to begin recording. After the specified time is up, the recording will end automatically.
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Starting the recording
To begin recording:
To begin recording, do any of the following:
•  Click the REC button on the control panel.
•  Use the start recording keyboard shortcut (F10 by default)

•  In the system tray, right-click the Movavi Screen Capture Studio icon  and choose Start Recording.
 
You will be given a 3-second countdown before recording begins.

The recording panel will change during capture:

On the left, you can see information about the recording:
Duration – the time recorded so far
Recorded – the recording size on disk
Left on Disk – how much free disk space you have left
 
In the middle, you can see which sound sources are being recorded and preview the webcam:

  – Webcam off/on

  – System audio recording off/on

  – Microphone audio recording off/on
 
To pause recording:
To pause recording, do any of the following:
•  Click the Pause button on the recording panel.

• 
 
Click the Pause button on the orange panel at the top of the capture frame: 

•  Use the pause capture keyboard shortcut (F9 by default)

•  In the system tray, right-click the Movavi Screen Capture Studio icon  and choose Pause.
 
When you're ready to resume the recording, the Resume button will be in the same location as the Pause button.
 
To stop recording:
When you're ready to finish the recording, do any of the following:
•  Click the Stop button on the control panel.

• 
 
Click the Stop button on the orange panel at the top of the capture frame: 

•  Use the stop recording keyboard shortcut (F10 by default)

•  In the system tray, right-click on the Movavi Screen Capture Studio icon  and choose Stop Recording.
 
The recording will end and the player window will open, where you can view and edit the video.
 
To cancel the recording:
If you want to terminate the recording without saving the video and delete the recording file, click Cancel on the recording panel.

Troubleshooting:
Windows style changes when I start recording
If you have a Windows Aero theme (Windows Vista, Windows 7), disabling the transparency effects will free more resources and your computer will run
faster during capture. The Aero theme will return once you have finished capture. To disable this, open the Preferences and turn off the 'Disable Aero
theme during capture' option in Video preferences.
 
Capture doesn't start immediately
By default, you will see a three-second countdown after you press the REC button and before the recording begins. You can use this time to prepare for
recording. If you want the recording to start immediately, open the Preferences and enable the 'Disable countdown' option.
 
An orange panel appears on my recording
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During recording, you can use the orange panel on top of the capture frame to take screenshots, pause or stop recording, and keep track of the recording
process. If you don't want this panel to appear on your videos, open the Preferences and disable the 'Show capture control panel during recording'
option.
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Editing captured files
When you end a recording, the player window will open, where you can view the finished video, save videos to a different format, and edit videos and
screenshots.

Here's what you can do:
Cut recordings – trim videos from the beginning or the end, cut out fragments.
Change recording format – save the video in a different video format, as an audio file, or even as an animated GIF.
Compress videos – trade off some of the quality for a smaller file size.
Publish online – upload the video straight to YouTube.
View previous recordings – all your earlier recordings and screenshots in one place on the history panel.
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Opening the player
 
To open the capture player and editor:
 
•   Open the Media Files menu and select Preview Recorded Videos.  

 
 

•   Right-click the Movavi Screen Capture Studio icon in the notification area and select Preview Recorded Videos.

Also, the capture editor will open after you finish recording a video.



 

44

Opening previous recordings
After you've finished a recording, it will open in the capture editor, where you can view and cut the file. If you want to edit the recording later, you can
open a recording file using any of the following:
 
Recent recordings
At the bottom of the capture editor, you can see a carousel of your previous recordings and screenshots. If you can't see the thumbnails, click the Recent
button in the bottom left to show the panel.
Tip: If you've changed the recording folder in File preferences, the Recent panel will only show recordings in the new folder.

Open a file
Open the Media Files menu and choose Open Recording File. Then, find the file in the Windows Explorer dialog box and click Open.

 

 

Storage location
The default locations for saving output files are:

•  "\Videos\Movavi Screen Capture Studio\" – for video recordings
•  "\Videos\Movavi Screen Capture Studio\Screenshots" – for screenshots

 
To change where the files are stored:
1. Open the Settings menu and choose Preferences.
2. In the Preferences window, switch to the Files tab.

3. To change the video storage folder, click the ellipsis button  next to Save output videos to and choose a new folder.

    To change the screenshot storage folder, click the ellipsis button  next to Save screenshots to and choose a new folder.
4. Click OK to accept the changes.
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Cutting recordings
This guide will show you how to cut out parts from video recordings using the built-in capture editor.
 
Before you start:
•  Open the recording you want to edit in the capture editor.
 
Step 1: Cut fragments
1. Move the position marker to where you want to cut the video.
 
2. Click the scissors button. A cut marker will appear at the current position.
 
Repeat these two steps to cut at the beginning and and at the end of each fragment you want to delete.

Precise positioning
For more precise positioning, click on the cut marker on the seek bar and do any of the following:
•  Click the previous frame and next frame buttons to move the cut marker by exactly one frame,
•  Click the arrows next to the time to move the marker by a small interval.
•  With the cut marker selected, use the arrow keys to move it left or right by 100 milliseconds.
•  Manually enter the necessary time.

Step 2: Delete fragments
1. On the seek bar, click a fragment to select it. The selected fragment appears as a darker shade.
 
2. To delete the selected fragment, click the trash can button.
 

A dotted line will appear on the seek bar where a fragment has been deleted: 
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How to undo cutting
To cancel a cutting action, click Undo at the top of the window or press Ctrl+Z. To repeat a cancelled action, click Redo. 
 
Step 3: Save the edited video
If you've cut the video, you need to save it to apply the changes.
 
1. Click Save As. The window with saving options will appear.
 
2. At the top of the window, choose a format for the video. If you don't know which format to choose, leave MP4 selected. It will save faster and at no
quality loss.
 
3. Choose where to save the file and enter a file name.
 
4. Click Save to start processing the video. This may take a while for longer videos.
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Changing the format
New recordings are created in the MKV format which is supported by most players. This guide will show you how to save your video recordings in a
different format. You can also convert your video recordings to audio by saving them as an audio format.
 
Before you start:
•   Open the recording that you want to change in the capture editor.
 
Step 1: Open the output options
Click Save As to open the output options.

Step 2: Choose a new format
At the top of the output options window, select a format you want to use.

Step 3: Name and location

Enter a name for your new file under File name. If you want to store the recording somewhere other than the default folder, click the ellipsis button 
next to Save to and choose a different folder.  
 
Step 4: Save the file
Finally, click Save to convert your recording to the selected format. This may take a while for large videos.
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Reducing output size
Long recordings with a large capture area size may take up a lot of disk space. In the capture editor, you can compress the video to a smaller file size by
trading off some of the quality.
 
Before you start:
•   Open the recording that you want to change in the capture editor.
 
Step 1: Open the output options
Click Save As in the bottom right-hand corner of the capture editor.  

Step 2: Set up compression
1. In the output options window, click the File size information.

2.  Use the Quality slider to change the output quality and reduce size:
•  Watch the bitrate and quality right above the slider. As long as the quality is High or Best, you most likely won't notice any difference.
•  If you need a specific size, you can enter it into the Size box. The quality will change to accomodate this size. Check the quality above to make sure you
haven't set it too low.
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What is bitrate?
Bitrate is the amount of data in each second of the video. The higher the bitrate, the more detail you can see. Bitrate is also affected by the resolution, so if
the file is still too large you may want to use a smaller capture area or convert the file to a lower resolution.

 
Step 3: Save the video
1. Under File name, name your new file.
2. To change the output folder, click the ellipsis button under Save to and choose a new folder.
3. Click Save to start processing the compressed video.
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Uploading videos online
Once your video is ready, you can share it to YouTube!

  
Step 1: Open the Export window
Click the Share button next to Save As and select YouTube.

Step 2: Sign in to your account
1. Click Sign In. The authentication page will open in your browser.
2. Sign in to your account and click Allow to let Movavi Screen Capture Studio upload videos.

Step 3: Choose a resolution
In the export window, open the Resolution list and choose a resolution that suits your video.
•  For best results, choose a resolution that is equal to or less than the height of your video. For example, if your video is 1280x720, choose the 720p
resolution.
•  This resolution will be the highest available quality available for your video. Lower resolutions will be generated automatically by the website.
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Step 4: Fill in the details
1. Fill in the title and description for your video.
2. Add some tags to help users find videos by relevant topics. Separate tags with commas.
3. Choose a category to help viewers find relevant content.
4. Open the Privacy box and choose who you want to see the video:
•  Private – only you can see the video.
•  Unlisted – the video will not appear for other people unless you give them the link.
•  Public – anyone can access the video.

Step 5: Save and upload the video
1. Before uploading, the video will be saved as a file on your computer. To change where the video file is stored, click Browse and select a folder.
2. Check the length and size of the video. YouTube allows users to upload videos up to 15 minutes. To upload longer videos, you need to verify your
account.
YouTube help – increasing your upload limit 
3. Click Start to begin saving and uploading the video.

https://support.google.com/youtube/answer/71673?hl=en
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Screen Recorder preferences
 
To open the program settings for Screen Recorder:
1. Open the Settings menu.
2. Choose Preferences.

The preferences window will open. The preferences are organized into relevant categories: General, Files, Keyboard Shortcuts, Video, Webcam, Effects,
Capture Time, and Sharing.
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General preferences
The General tab allows you to change the basic behavior of the program.

 

 Disable countdown
Every time before the recording starts, you will see a 3-second countdown. This gives you time to prepare for your recording. Select this option to turn the
countdown off and start recording immediately.
 

 Show capture control panel during recording
The capture control panel will appear on top of the capture frame while recording a video. You can use it to pause or stop capture, take a snapshot, or see
how much space the recording has taken up. If you are recording a full screen video, the panel will not be visible.

 Allow window panes selection
To record only the main window panes (no frames, menus or browser tabs), Movavi Screen Recorder needs access to your screen.

 

 Capture separate streams
When recording a video, the webcam, main onscreen video, external audio, etc. will be recorded as separate streams, like layers.
This can be useful for editing the video later, so you can edit them separately.
 

 Sound notifications
The program will notify you when a screenshot has been taken, a file export is finished, or if an error occurs.
 

 Launch application at startup
With this option enabled, Movavi Screen Capture Studio will start when you log in and run in the background. This way you will always be ready to
capture your screen.
 

 Use software OpenGL implementation (advanced)
This option can troubleshoot OpenGL problems for some graphics cards.
 
OpenGL is a software interface that manages graphics output. Usually, OpenGL is handled by your graphics card driver. However, some graphics cards do
not support the necessary version of OpenGL. For these graphics cards, you can use this option to download and install a software replacement. Installation
will run automatically, but you will need an Internet connection to download the files.
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 Save extended logs for troubleshooting
In case you experience trouble using the program and contact our support team, they might ask you to collect logs. The logs contain the program's actions
for some period of time, as well as important error reports and descriptions. Extended logs give the most amount of information which may be essential to
solving your problem.
Learn more: How to collect logs
 

 Automatically check for updates
The program will notify you if a new version is available. Minor updates are absolutely free (for example, from v.1.3 to v.1.4). For major updates users
with purchased Movavi Screen Capture Studio license will get a considerable discount.
 

 Send anonymous usage stats to Movavi
Enabling this box will allow Movavi Screen Capture Studio to send us anonymous data about how you use the program. This data does not contain any
personally identifiable information and is only used for improving our software. You can find more information about how we use the statistics on our
Movavi Improvement Program page.

 

http://www.movavi.com/mip.html
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File preferences
In the Filessection of the preferences, you can change where your captured files are stored. To change a folder location, click the icon with the dots and

select a new folder: 

Save output videos to...
This is where all your video recordings are saved.
 
Delete original recording after saving
If you save the recording in a different format, or trim the file, the original will be deleted.
 
Save screenshots to...
This is where all your new screenshots are saved. You can also find your recent screenshots in the editor window.
 
Default screenshot format
Here you can change the format for all new screenshots. You can also change the format for a single screenshot by using the Save As button in the editor
window to save a copy with a different format.
 
Default screenshot format
Here you can change the format for all new screenshots. You can also change the format for a single screenshot by using the Save As button in the editor
window to save a copy with a different format.
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Keyboard shortcuts
On the Keyboard Shortcuts section, you can set your own shortcuts.

To change one of the shortcuts:
1. Click inside the box with the shortcut you want to change. The box will become blank.
2. Simultaneously press on keyboard the keys you want to use as a shortcut to the selected action. The box will now display your custom shortcut.
3. Click OK to apply the changes. To reset all the keyboard shortcuts to their original state, click the Reset to Default button.
 
If you forget a shortcut, you can always look it up here in the keyboard shortcut settings.
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Video preferences
On the Video tab, you can choose how the videos are recorded and saved, change the preferred audio quality, including the sample rate, number of
channels, and bits per second.

Frame rate
The frame rate defines how many frames will be captured each second and affects the smoothness of motion in the video. A lower frame rate will result in
smaller output size, however, the video may not turn out as smooth. The recommended frame rate is 20-30 frames per second.
 
Output frame size
Usually, your desktop is recorded at full size. This option allows you to reduce the original video quality to 1/2 or 1/4 of the original. The video file will
have lower quality, but take up less disk space. This can also improve performance while recording on slower computers.
 
Sample rate
The first number is the audio sample rate, measured in Kilohertz (kHz). This is the number of digital samples taken each second to record sound. Higher
sample rate usually means higher quality. 44.1 kHz is the recommended sample rate, which corresponds to the human hearing range.
 
Channels
Mono uses only one audio channel, which saves some disk space.
Stereo uses two audio channels, which allows distinguishing the direction a sound is coming from and usually sounds more natural.

 
Bit depth
Movavi Screen Recorder will record audio at 16 bits, which is the standard bit depth for most audio recordings. This means that every sample contains 16
bits of information to encode sound.
 
Enable SuperSpeed conversion
This option will make saving videos faster if you use the same output video codec. For example, if you cut the video without changing the format. Formats

that work with SuperSpeed are marked with these icons:  or  in the list. If you're having problems with saving some files, try disabling this
option.
 
Enable Intel hardware acceleration
This option will make saving videos faster if your computer is equipped with a compatible Intel® graphics chip. Intel acceleration works when processing
H.264, MP4, and MPEG-2 videos.
 
Enable NVIDIA GPU acceleration
This option can make saving videos faster by using the graphics card to process media files. This leaves the CPU free for other tasks and improves
performance while saving videos. This option is only available if you have an NVIDIA® graphics card compatible with the NVENC® or CUDA®
technologies.  
 
Disable Aero theme during capture
Windows Aero themes that use transparency require more processing power. This may slow down your computer while recording video. With this option
enabled, the program will disable the Aero theme while recording to improve performance. The theme will be restored after recording has finished.
(For Windows Vista and Windows 7)
 
Use DirectX for capturing
Try this option if you are experiencing problems capturing some program windows. In Windows 8 and above, the capture method is chosen automatically
and this option is unavailable.
(For Windows 7 and earlier)
 
Use alternative capture mode
If you get an error message  when you start or stop recording your screen, try this option. If the problem isn't solved, click here to read full troubleshooting
instructions.

http://kb.movavi.com/article.php?id=290
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(For Windows 8 and above)
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Webcam preferences
The Webcam section of the preferences allows you to set up your webcam for recording it on top of the main video. 

Enabling the webcam
1. Connect the camera to your computer and wait until your system installs the necessary drivers.
2. In the Webcam preferences section, select the camera you want to use from the 'Use this webcam' box.
 
If the camera does not appear in the list, try manually installing the driver that came with your camera. You can use the preview square on the right to
check that the camera is working properly.
 
Webcam properties
Clicking the Settings button will open the camera's properties. These properties are different for each manufacturer, but generally you can use them to
calibrate the brightness, contrast, and exposure of your camera.
 
Resolution
The resolution affects the quality of the output video. If the video is very small, you can choose a lower resolution without a noticeable decrease in quality.
 
Frame rate
Frame rate is the number of shots the camera takes each second. Higher frame rates will make the movements look smoother and work best for videos with
a lot of motion. If the picture is mostly static, you can decrease frame rate to save disk space. The standard frame rate is 20-30 frames per second.
 
Video size
Use the video size slider to set the size of the webcam overlay relative to the main video.
 
Position
Use one of the position options to choose where your webcam overlay will be placed on the original video.
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Effects
In the Effects section of the preferences, you can set up the visibility of your mouse and keystrokes.

Cursor options
Select Show cursor on recording to make the cursor visible to your viewers.
 
Highlight cursor
This option will add a bright circle around the mouse cursor to make it more visible.
1. Select the Highlight cursor option.
2. Click the square on the right to choose the highlight color. Use the Alpha channel box to change its opacity.
3. Use the size slider to change the size of the highlight circle.
Hint: hover your mouse over the preview square on the right to see how it will look on the recording.
 
Highlight clicks
This option will flash a circle around the cursor for every click. You can set two different colors for the left and right mouse buttons.
1. Enable the Highlight clicks option.
2. Click the left square to set the color for the left mouse button.
3. Click the right square to set the color for the right mouse button.
 
Mouse click sound
A clicking sound will be played every time you click the mouse to draw attention to your actions.
1. Enable the Mouse click sound option. The default mouse click sound will be used.
2. (optional) If you have a file with a different sound effect you want to use, open the box under 'Mouse click sound' and choose Add sound. Then, open
the audio file with the sound effect. You can use WAV, MP3, AIFF, and AU files.
 
Keystroke recording options
•  Keyboard shortcuts only – only functional keys and key combinations (for example, Alt+Shift, or Ctrl+C) will appear on the video.
•  All keystrokes – all key presses, including letters of the alphabet, will appear on the video.
Hint: avoid entering passwords when this option is enabled if you don't want everyone to see your password.
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Capture time preferences
In the Capture Time section of the preferences, you can start and stop recordings automatically.

Automatically ending a recording
1. Select the "Start manually and end after" option.
2. Enter the duration of the recording into the box on the right (hours: minutes: seconds).
 
Scheduling a recording
To start and end a recording automatically:
1. Select the "Start and end on schedule" option:
2. Next to "Start time", enter the time and date when the recording should start.
3. Next to "End after", enter the duration of the recording (hours: minutes: seconds).
 
The Screen Capture application must be running at this time for the recording to begin. To make sure you don't miss it, enable the "Launch application at
startup" option in the General section.
 
After capture
If you've scheduled a recording, you can tell your computer to automatically sleep or shut down after the recording is finished. The recording file will be
saved.
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Sharing preferences
The Sharing tab allows you to manage your YouTube accounts used to upload videos to.

To sign in to your YouTube account:
1. Click Sign In. The authentication page will open in your browser.
2. Sign in to your account and click Allow to let Movavi Screen Capture Studio upload videos.
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Edit video
Using the Video Editor application, you can join your recordings with other media files, annotate your videos with titles and arrows, create overlays, apply
effects, and much more.
 
How to open the Video Editor
From the launcher
In the Movavi Screen Capture Studio launcher, click Edit video to create a new video project.

Edit a recording
In the capture editor window that appears after you've finished a recording, click Open in Editor to open the selected recording for further editing. The
recording will be added to the Timeline as separate tracks: video, system audio, microphone audio and the webcam overlay can be edited separately for
maximum flexibility.

 
Video editing tutorials

Annotating videos with callouts
Add arrows and speech bubbles to your videos.

Adding titles
Add text and subtitles to your videos.

Creating overlays
Move your webcam video, add a picture-in-picture or watermark.

Using the Pan and Zoom effect
Zoom in on parts of your recording to show the most important details.

 
 
 



 

65

Activating and installing packages
Expansion packages are the sets of additional content which include transitions, titles, stickers, backgrounds and music. The packages are created to help
you achieve your creative goals, broaden your freedom of expression and save your time choosing the right artistic tools.
 
Step 1: Acquiring the package
To use the content expansion packages, open Movavi Video Editor. Switch to the Transitions, Titles or Stickers tab. Then find and click the Store button
at the bottom of the categories list or find the More Effects element in any of the effects categories. You will be redirected to the Movavi Effects Store
web-page to choose and purchase the packages.

Step 2: Making a purchase
On the website, choose and purchase the set you like. After the purchase is processed you will receive an e-mail with an activation key, a link to download
the package, and an instruction on how to install it.
 
Step 3: Installing a package
Click the link you received with the e-mail and download the package. When the downloading is finished, open the package as you normally would open
your project: double-click the file or drag and drop it in the Video Editor. The program will run the installation process. In the Installing Package window
click Install and follow the instructions on the screen.

Step 4: Activating a package
Copy the activation key from your e-mail and Paste it in the in the Activating Package window and click Activate.

 
Wait until the installation is finished. The new elements will appear in the corresponding categories of the Video Editor. The categories with the new
elements will have a blue dot on them and the elements will be marked with the NEW label.
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Cannot install or activate the package? Make sure that:
•  The Video Editor you have installed on your system supports the packages;
•  You use the key that was sent to you after the purchase of a package and there are no additional symbols after the key;
•  You have enough free disk space to install the package.
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Easy mode  – quick start
How to make a video using the Montage Wizard

In easy mode, you can use the Montage Wizard to automatically build a video for you in minutes. All you need to do is provide the wizard with some
video clips or photos, choose a music track, and let the Wizard cut and build the video for you. You can also use the Montage Wizard to make slideshows.
 
Step 1: Open the Wizard
•  If you've just started the Editor, click Create a montage in easy mode on the welcome screen.
•  Or open the File menu and choose New Montage.

Step 2: Add files
On the Files tab of the Wizard, add the videos and photos that you want to see in your video.
•  Click +Files to add several files from one folder,
•  Click +Folders to add the entire contents of one or more folders,
•  Or drag and drop the files onto the Wizard window.

The files you've added will appear below. You may need to wait a couple minutes for all the files to load.
•  To change the order of the files, simply drag their thumbnails with your mouse.

•  To remove files from the video, click the  in the upper right-hand corner of each file, or select the files you want to delete and click the trash can
button above the list.

Step 3: Add music
Click Next or the Music tab at the top to proceed to the next step. Here you can choose music to play along with the video. You can add your own audio
files or use any of the provided audio clips listed in the left-hand column. These audio tracks are royalty-free so you can upload these videos to YouTube
and other services.
 
•  To use one of the built-in tracks, click the + button. 
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•  To add your own audio file, click the +Music button at the top and select the audio track, or simply drag the file onto the Wizard window.

The audio tracks selected for this video will be listed in the right-hand column.
 
Step 4: Add transitions
Click Next or the Transitions tab to move to the next step. Choose among the given types of transitions.

Step 5: Preview and adjust your video
You're almost done! Click Next or the Preview tab at the top to proceed. If you've added a lot of videos, you may have to wait up to a couple minutes
while the Wizard does its magic. You can then preview the video and make some adjustments to get it just right.

Video length
By default, the video will be just as long as the background audio. To change the length, deselect the Fit to music length option and use the slider to set
how long you want the video to be. If you opt for a shorter video, some clips may not appear in the end result.
 
Black bars removal
If the files in your slideshow are of different resolution than the project
If the resolution of the project and the files in your slideshow are different, black bars will appear. You can remove them by checking the Fit to frame
option – the image resolution will be automatically fitted to the frame size.
Learn more about frame size
 
Volume balance
The volume balance slider determines what kind of sounds you can hear in the video. Move the slider to the left side to hear more of the video sounds
(such as speech and ambient sounds), or move the slider to the right to make the video's sound quieter and raise the background music volume.
 
Learn more:
Adding filters
Adding titles
Color adjustments
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Removing black bars
 
Step 6: Save the finished video
Finally, click the Export tab at the top and decide what you want to do with your finished video.

Save the video – choose this option to save the result as a video file.
Continue editing – this will close the wizard and let you add finishing touches in full-feature mode. After you're finished, you can always click the big
green Export button at the bottom to save the result.
Share on the web – choose this option to save a video file and upload it to YouTube or Google Drive right away.

To save the video, choose a video format you want to use and pick a folder to save the video file. If you're uploading the video to YouTube, sign in with
your YouTube account and fill in the details about your video. Then, click Start to begin saving your video file.
Learn more: Exporting videos | Uploading to YouTube
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Full-feature mode – quick start
How to make a movie in full-feature mode

In full-feature mode you can use all the tools that the Video Editor has to offer and create professional-looking videos without complicated software.
 
Step 1: Create a project
On the welcome screen, click Create a project in full-feature mode to begin making your movie.
Learn more: Creating and managing projects

Step 2: Add files
Now it's time to add the files that'll make up your movie. On the Import tab, click Add Media Files and choose the files you want to use.

Learn more: Adding files | Recording video | Recording audio | Using built-in media
Step 3: Cut clips
To split clips or cut out unwanted bits, use the scissors button on the toolbar:
1. On the Timeline, select the clip you want to cut.
2. Place the position marker where you want to split the clip.
3. Click the scissors button to cut in the current position.

To delete parts, repeat the steps to cut off the unwanted fragment so that it is a separate clip, then select it and click the trash can button.
 
Step 4: Add and edit music
You can add audio files the same way you add videos and photos: on the Import tab, click Add Media Files and choose the audio file you want to use. The
audio clip will appear as a blue ribbon at the bottom of the Timeline. To change the volume and edit the audio track, select it on the Timeline and click the
Audio properties button. 
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Step 5: Annotate your video
1. Click the Titles button on the left.
2. Pick a text style in the list and drag it onto the uppermost track of the Timeline. The text clip will appear as a purple ribbon.
3. Double-click the title clip and edit the text in the player. Here, you can change the font, color, and other properties of the text.
4. To change how long the text appears, drag the edges of the title clip on the Timeline.

Step 6: Save your movie
When you're finished with your video, it's time to save it in a format that can be viewed in any video player.
 
1. Click the Export button to open the exporting options.
2. In the Export window, choose a format you want to save the video in, and name your movie.
3. Finally, click Start to begin processing the video. Your video will be ready in a few minutes.
Learn more about saving your video

Tip: Make sure to save your work once in a while: choose Save from the File menu to save the project so that you can access it later.
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Creating and managing projects
 
When you work on your movie, all the changes you make are stored in a project. A new project is created automatically when you start working on a
video.
 
To create a new project:
•  On launching  the Video Editor: click Create a project in full-feature mode if you want to make the video yourself or Create a montage in easy mode
to make a quick automated video.
•  In full-feature mode: open the File menu and choose New Project for a new video in full-feature mode, or New Montage to start in easy mode.
 
After that, you can save your project as a file in the *.mepb format on your computer and open it later to continue editing your movie.
 
How can I play my project?
Project files cannot be viewed in a regular video player, but can only be opened with Movavi Video Editor. To view the finished work in a player, you
need to first export your movie to a common video format.
Learn how to export your project
 
Saving projects
To avoid losing your editing progress, make sure to save your project every once in a while. To save a project, open the File menu and choose Save
Project.
Saving projects
 
Opening projects
To open a previous project, open the File menu and choose Open. Then, find the project file and continue working on your movie.
Learn how to open projects
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Saving a project
A project stores all the work on your movie or slideshow. You can save the project for finishing your work later, or restore your work if you
need to edit something after you've finished.
 
Saving the project
1. Open the File menu and choose Save Project.
2. You will be asked to enter a name for the project. Your project files should be stored in the "\My Videos\Movavi Screen Capture Studio
\Projects" folder of your user. 
3. Click Save to confirm saving.

How to change where projects are saved
1. Open the Settings menu and choose Preferences.
2. Click the Files tab.
3. Find the Save project files to box and click the button next to it to choose a different folder for storing your projects.
4. Select the folder you want to use and click Select Folder. 

See also:
Project settings
Exporting videos
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Opening a project
Open a project to continue working on your video.
 
Where are my projects located?
By default, your projects are saved to "\My Videos\Movavi Screen Capture Studio\Projects", but you can save your projects anywhere else
you like.
 
How to open a project
A: Find your project in Windows Explorer and drag it onto the Video Editor window.
 
B: Find your project in Windows Explorer and double-click it to open it.
 
C: Click Open Project on the welcome screen. Then, locate the project file in the Windows Explorer box and click Open.
 
D: Open the File menu and choose Open Project. Then, locate the project file in the Windows Explorer box and click Open.
 
Restoring work from an autosave
If your computer malfunctions and you cannot save the project, some of your work may be restored using an autosave file. Simply rename the
"autosave.mepb" file and open it in the Video Editor to continue working on your project.

Media use
When you open a previously created project, you may see a message saying that a file is missing from the project. This may happen if one of the files used
in the project has been moved somewhere else or deleted from disk.  In this case, click Browse in the message box to find the file in its new location, or
click Skip to open the project without the missing file. We recommend that you copy all the files to your hard drive before editing.
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Project settings
How to change the video's resolution

Project settings affect your entire project and define how different kinds of videos, photos, and audio files are composed into your finished video. You can
set up your project's video and audio settings when creating the project or at any other time.
 
Opening project settings
•  On the bottom panel of the Video Editor, find the pencil icon next to the information about your project 
•  Open the Edit menu and choose Project Settings,
•  Or click the pencil icon in the Export window when saving the video.

Video settings
The video settings apply to all videos and photos used in the project. When you import the media files, they will be scaled to fit inside the selected frame
size according to your settings. 
 
Resolution
The frame size or resolution determines the videos width and height in pixels. Open the Resolution list to select from the most common resolutions. For
your convenience, each resolution is marked with its respective aspect ratio. Ideally, the frame size should match the resolution of the videos and photos
you plan to use in your project, and should not exceed the resolution of the largest video. Smaller resolutions allow you to make the output video smaller
and thus save your disc space, however, this will sacrifice some video quality due to downscaling.

Frame Size Aspect Ratio

320x240 4:3

640x480 4:3

1280x720 16:9

1280x960 4:3

1920x1080 16:9

1920x1440 4:3
Aspect ratio
The aspect ratio is the ratio of the video or photo's width to its height. The most commonly used aspect ratios are 4:3, used generally for analog TV and in
many old movies, and 16:9, the standard resolution for widescreen digital video.

A relative comparison of aspect ratios
 

When you add videos and photos to the project, they will be scaled to fit the specified frame size. If you add media files with an aspect ratio different
from that of the project, you may see black bars appear on the sides of the video. Furthermore, if you add low-quality videos to a project set up to a high
resolution (frame size), the small video may be stretched to fit the frame and thus may appear pixellized. For best results, we recommend setting the frame
size and aspect ratio to match all or most of the videos and photos you are planning to use.

 
Examples of black bars appearing when importing videos with a different aspect ratio.

 
If you cannot find the necessary frame size in the list, you can manually enter the width and height into the respective boxes of the Project Settings

window. Note the button with the link icon to the right of the boxes. It allows you to maintain existing proportions when entering new values:   – the
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proportions are constrained, allowing you to set a larger or smaller frame size without changing the aspect ratio;  – you can freely enter the width and
height with any proportions. Simply click this button to toggle the two states.
 
Resize method
Choosing a resize method can help you manage how all of your videos and photos are resized to fit inside the frame size you've set. This is especially
important when the aspect ratio of some videos and photos does not match the aspect ratio of the project and you need to get rid of the black bars. There
are three resizing options available:
 
Letterbox – the video will be resized to fit inside the frame entirely. This method allows you to keep the whole video inside the frame without distortions,
but may place black bars around the video.

Stretch – the video is fit entirely inside the frame and then stretched on one axis in such a way as to fill the entire frame without leaving black bars. This
allows you to cover the entire frame, however, the objects in the video may appear horizontally or vertically distorted.

Crop – the video will be resized to be slightly larger than the frame, cropping the parts that do not fit inside it. This allows to cover the entire area of the
frame without distorting any of the objects inside the video or without leaving black bars, however, this may not suit some clips where important objects
are near the edge of the frame.

Audio settings
Sample rate
The sample rate affects the quality of digital sound, and defines the maximum frequencies that an audio stream can contain. The default sample rate is set
to 44100 Hz, which exceeds the maximum frequencies of human hearing and is used to record Audio CDs and most music tracks.
 
Channels
Stereo sound contains two channels and has the capacity to convey the relative location of sound sources, which makes it best for recording music; mono
sound has only one channel and produces sound without differentiating left and right channels. Stereo is the generally preferred number of channels,
however, some mobile devices record sound only in mono mode. 5.1 surround sound comprises six audio channels. It is one of the most popular to be
used in home theater systems.
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Adding media files
To begin working on your video project, you will first need to add some media files to the Editor.
 
Step 1: Open the Import tab
The Import tab is the first one you see when you start a new project. To open the Import tab, click the very first button in the upper left-hand corner of the
window.  
 
Step 2: Go to the My files section
In the left part of the Import tab, you can switch between adding your own media files or using built-in clips. Click on My files to show file import
options.

Step 3: Open files
1. Click Add Media Files.
2. A Windows Explorer dialog box will open. Locate your files or folders and click Open.
 
If you want to add the entire contents of one or several folders, click Add Folder, select the folder(s) you want to use and then click Select Folder to add
the files.

Step 4: Arrange the files
Once you've added the files, they will appear on the Timeline at the bottom of the window. The Timeline allows you to arrange the clips in the order you
want. The clips' position relative to the time ruler at the top of the Timeline determines when it will appear in the finished video. To reorder the clips, select
the clips you want to move and then drag them to the new position on the Timeline.
Learn about using the Timeline

Moving a clip on the Timeline

See also:
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Working with video
Working with audio
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Using built-in media
Movavi Video Editor comes with an extensive collection of built-in royalty-free music, sounds, videos and backgrounds that you can use in your videos.
 
Step 1: Open the Import tab
Click the Import button in the upper left-hand corner to open the media options.

Step 2: Choose a media type
On the left side of the Import tab, you can switch between using your own media files and adding clips from the stock collection.
 
•  Sounds – fun sound effects and audio samples to make your videos more expressive.
 
•  Music – instrumental tracks for your background music.
 
•  Sample video – video clips that you can use as intros, overlays, and animated backgrounds.
 
•  Backgrounds – image backdrops for your titles and transparent clips.

 
Step 3: Download media files

You need to download built-in media to use it. If a thumbnail has a download icon , it means the file has not been yet installed to the category. To
download it point the cursor at the media thumbnail. The "Click here to download" message will appear. Click on the thumbnail. The download will start
and a progress bar will appear. When the download is finished, you can use the media file.

You can cancel the download by clicking the Stop icon .

You can also download the whole category at once. To do this, open the tab you need and click the download icon  next to the category name. All the
files in the category will be downloaded.
*If your device has a limited amount of space or running out of it, choose the option where you can download only the media you want to use.
 
Step 4: Add the clip to your project
To use a stock clip in your project, pick a clip you like and drag it onto the Timeline.
 
•  Drag sample video clips and backgrounds onto the video or overlay track,
 
•  Drag sounds and music onto the audio track. To link a sound clip to a video clip, select it on the Timeline and drag it up, towards the video track until a
line appears between the audio clip and the video clip. Now, when you move the video clip, the sound will stay in sync.
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An error occured while downloading the media files
An error can occur in case if there is no internet access. Check your internet connection and restart the download by clicking on the files on which the error
occured. The clips will be downloaded and stored in your "\My Videos\Movavi Screen Capture Studio\Media Content" folder.
 
Want more content?
Movavi Video Editor Plus has more built-in media files: 12 additional music tracks, 16 video clips, and 76 stickers, as well as an animation tool and more
new features. Get it here

https://www.movavi.com/video-editor-plus/?asrc=ve_help
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Recording audio
After you've added some videos and photos to the Timeline, you can record audio from a microphone or any other recording device.
 
Step 1: Open audio recording options
On the toolbar, click the microphone button to open audio recording options.
* There must be at least one clip on the video track.

Step 2: Set up recording
1. In the Audio device box, choose the device you want to use.
 
To record from a microphone: choose your preferred microphone or webcam microphone. If you don't see the device in the list, try reconnecting it to
your computer.
 
To record audio from the computer: select Stereo Mix from the list. This will allow you to record any music, alerts, or other sounds playing on your
computer. If you don't see "Stereo Mix" in the list, it may be disabled on your computer.
 
2. (Advanced) In the Audio quality box, choose the sample rate and number of channels that you need.
 
3. Set the volume level you want to use in your project.

4. On the Timeline, place the progress marker to where you want the recording to begin. You will be able to move the clip later.
 

Step 3: Record sound
1. When you're ready, click Start Recording. You will be given a three-second countdown.
 
2. The video will start playing simultaneously with the recording. This way, if you're recording a voice-over, you will be able to use the video as a visual
aid as you speak.
 
3. When you're done, click Stop Recording. The recorded audio clip will already be on the Timeline, as a linked audio clip.
* The recording will stop automatically if it reaches the end of the video track.

timeline_tracks.htm#linked_audio
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Recording video

Follow the steps below to record video from a camera that's connected to your computer.
 
Step 1: Connect the camera you want to capture from to the computer. Make sure that the system recognizes the device and that it is working correctly.
 
Step 2: On the Import tab of the Video Editor, click Record Video. The recording module will open in a separate window.

Step 3: In the Video capture device box, choose the camera you want to use for capture. Then, select the resolution and frame rate. A larger resolution
will be able to retain better quality, however, the video file size will be larger. A higher frame rate is necessary for recording motion, while static scenes
can be captured with a lower frame rate.
 
Step 4: In the Audio capture device box, choose the microphone that you want to record the sound with.

Step 5: (Optional) By default, the recordings will be saved to your Movavi Library folder. If you want to save them somewhere else, click the folder

button  under 'Save files to' and choose a different location.
 
Step 6: (Optional) If you want to batch rename the files, choose a renaming option from the 'File renaming' box and set up the new file name template. 
 

Step 7: Click Start Capture to begin recording the video. During capture, you can take snapshots using the camera button  on the right.
 
Step 8: To finish the recording, click Stop Capture. If you need to record more videos, repeat steps 7 and 8.
 
Step 9: When you're done, click Back to editing at the bottom of the window. The captured files will be added to your project's Timeline. Also, they are
saved to disk in case you want to use them later.
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Importing AVCHD video

Follow the steps below to import previously recorded videos from an AVCHD camera.
 
Step 1: Connect the camera you want to capture from to the computer, and enable USB connection mode on your camera. Make sure that the system
recognizes the device and that it is working correctly.
 
Step 2: On the Import tab of the Video Editor, click Record Video. The recording module will open in a separate window.

Step 3: In the Video capture device box, select your AVCHD camera.

Step 4: On the left, you will see a list of all clips on the camera storage. Review the files and deselect the ones you don't need.

Step 5: (Optional) After importing, the files will be saved to your Movavi Library folder. If you want to save them somewhere else, click the folder

button  under 'Save files to' and choose a different location. 
 
Step 6: (Optional) If you want to batch rename the files, choose a renaming option from the 'File renaming' box and set up the new file name template. 
 
Step 7: Click Add files to the Editor to start copying the files. This may take a while depending on the size of the videos.



 

86



 

87

File information
Find the file's location
To find the location of the clip's original file, right-click on the clip on the Timeline and choose Show in Folder from the menu.

See a clip's media information
To see a clip's media properties, right-click it on the clip Timeline and choose File Information from the menu.

A small File Information window will appear. Here, you can find the resolution, aspect ratio, and other properties of the original file. Knowing certain
information about a clip will allow you to better understand which settings are best for your videos.
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Preview and organize clips
Use the player in the upper right-hand part of the window to preview your project.
 
Current position
Your current playback position can be controlled using the position marker under the player and on the Timeline.

For precise positioning:
•  To move in 0.5 second increments, open the Playback menu and choose Skip Forward by 0.5 Seconds (Shift+Ctrl+#) or Skip Backward by 0.5
Seconds (Shift+Ctrl+#).
•  To move precisely from frame to frame, use the Previous frame (Ctrl+#) and Next frame (Ctrl+#) buttons in the player. This will move the position
marker exactly one frame backward or forward.
•  Use the Scale slider to zoom in on the Timeline to make positioning easier.

Playing the video
1. Move the position marker to where you want to start playback.
2. Click Play or press the Space Bar key. 
3. Click the Pause button or press the Space Bar again to pause playback.

1 – player position marker
2 – current time
3 – previous frame
4 – play/pause

5 – next frame
6 – unpin player
7 – view in full screen mode
8 – player volume

 
Arranging clips
By default, media files will appear on the Timeline in the same order in which you've added them. To rearrange the clips, drag them with your mouse and
drop them onto the desired position. To select multiple clips, use Ctrl+click or click and drag to draw a selection on the Timeline.

Working with two monitors



 

89

If you have more than one monitor, you might want to detach the player into a separate window to have more room for editing. To do that, click the Unpin
player button under the player:

 
The player will then open in a separate window. When you want to return the player back into the main window, click the Pin player button in the
detached player or close the player window.
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Timeline tracks
The Timeline at the bottom of the window is your working area where you can organize and edit the clips that make up your video project. The Timeline
consists of several tracks for different types of media, that are all synchronized against the time scale at the top. You can imagine the tracks as layers: the
uppermost layer appears on top of all others. With the exception of the video track, you can layer several clips on each of the tracks to make your video
more dynamic.

Video track
The video track holds videos, pictures, and the transitions between them. You can also place titles, callouts and stickers on the video track if you want them
to appear against a black background.

Overlay track
You can use the overlay track to show videos and images on top of the main video track. Simply drag the clips from the main video track up onto the
overlay track. Overlay clips are linked to a corresponding clip on the main video track. This way, they will stay in sync even of you move or cut the video
clip.
Learn more: Creating overlays

Title track
The title track holds all of your text clips, as well as callouts and stickers. Clips on this track are linked to a corresponding clip on the main video track.
You can't use transitions or effects on any of these clips.
Learn more: Titles | Callouts | Stickers

Independent audio track
The independent audio track is the very last track of the Timeline and it contains audio that is not linked to any clips on the video track. This track is
most suitable for background music and clips that don't need to be synchronized to videos. Both audio tracks show waveforms that visualize the volume
throughout the clip, so that you can easily find the quietest and loudest parts. You can also fine-tune the volume using volume curves.
Learn more: Volume curves
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Linked audio track
The linked audio track allows you to link audio clips to videos and images on the video track so that the audio clips stay in sync as you edit your project.
The linked audio clip is hidden by default, but you can link clips by dragging them a little but up, towards the video track until a blue line appears,
connecting the audio and video tracks. If you record audio, the audio clip will also appear on this track.

 
Problem: My audio clip appears on the video track
Solution: Some audio files contain album art, which may sometimes be recognized as the video stream. Therefore, these files may be placed on the video
track. In that case, drag the audio clip down onto the audio track, and delete the album art from the video track if you do not need it.
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Hiding and muting clips
If you want to see how your project looks without some clips, you can disable separate clips or entire tracks.
 
Hiding clips
To hide a clip from view, right-click the clip and choose Hide Clip from the pop-up menu. The clip will not appear in the player or on the finished video
until you re-enable it.

Muting clips
To disable a clip's sound, right-click the clip you want to mute and select Mute Clip from the pop-up menu. The clip will not play in the player or on the
finished video.

Disabling tracks
•  To hide an entire track from view, click the eye icon  to the left of the track you want to hide.

•  To disable the sound for an entire track, click the speaker icon  to the left of the track.
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Zooming the Timeline
To change the zoom level of the Timeline, drag the Scale slider at the bottom of the window. Move the slider left to zoom out, and move the slider right to
zoom in on the Timeline.
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Undo actions
How to cancel a previous action

It's okay if you make a mistake or change your mind while editing videos because almost any action can be reversed!
 
•  Click the Undo button on the toolbar or press Ctrl+Z to cancel an action.
•  If you've cancelled an action but want to return to it, click the Redo button or press Ctrl+Y.
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Cutting video
Use the scissors button on the toolbar to cut video and audio clips into parts. To delete a clip you don't need, click the trash can button.

Splitting clips into parts
Step 1: Select the clip that you want to split.
Step 2: Move the position marker to the moment where you want to cut the clip.
Step 3: Click the Split button on the toolbar.

Cutting out fragments
Step 1: Cut the clip at the beginning of the unwanted fragment

1. Select the clip you want to cut.
2. Move the position marker to the beginning of the fragment. Use the Previous Frame and Next Frame buttons on the player to catch the moment
precisely.
3. Click the Split button. The clip will be cut into two parts, with the unwanted fragment at the beginning of the second clip.

 
Step 2: Cut the clip at the end of the fragment

1. Select the second clip the you've just cut off.
2. Move the position marker to the end of the fragment.
3. Click the Split button again. The fragment should now be in a separate clip.
 

Step 3: Delete the unwanted fragment
1. Select the clip with the unwanted fragment.
2. Click the trash can button or press the Delete key to remove this clip. The clip will be removed, and the remaining clips on the Timeline will
move to close the gap.
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Trimming clips
If you only need to cut off some parts at the beginning or at the end of a video or audio clip:
Step 1: Place your mouse pointer over the edge of the clip.
Step 2: Click and drag the edge towards the center of the clip to trim the clip to the desired length.

For more precise navigation:
•  Open the Playback menu and use the Skip Forward by 0.5 Seconds or Skip Backward by 0.5 Seconds commands to jump half a second forward or
back.
•  Use the keyboard shortcuts to move the position marker half a second back and half a second forward, respectively: Shift+Ctrl+# and Shift+Ctrl+#.
•  Use the Previous Frame and Next Frame buttons for precise frame-by-frame navigation. You can also use the Ctrl+# and Ctrl+# keyboard shortcuts.
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Edit and enhance clips
After you've added some videos and images to your project, they will appear on the video track of the Timeline, where you can move and arrange them
into a movie. Next, it's time to edit and enhance the clips.
 
Cut video clips
On the Timeline, select the clip that you want to cut and move the position marker onto the moment where you want to split the clip. Then, click the
scissors button on the toolbar to split the clip into two parts.

Edit videos and images
Photos and videos aren't always perfect from the beginning. Use the buttons on the toolbar to fix and adjust the clips.
 

Learn more: Rotating video | Cropping video | Color adjustments | Volume | Speed | Reversing video | Image duration | Fades | Video properties

Picture in picture and overlays
To overlay one video or image on top of another, select the clip you want to show on top and drag it up, towards the top of the Timeline to create an extra
overlay track. Then, double-click the upper clip to set up where the overlay will be shown on the video.
Learn more about overlays

Picture and picture, side by side overlay modes.
 
Removing black bars
Some videos and photos may have black bars around them in the player. This can happen because the clip's proportions are different from the project, for
example, if you add a vertical video. To fix this, you can crop the video or use the special Vertical fill filter.
Learn more about removing black bars
 
Creating freeze frames
A freeze frame is a still shot inserted in the middle of a video for dramatic effect. You can use the freeze frame to emphasize a very fast movement or
pause the action while you give additional information.
Learn more about freeze frames

Before and after adding a freeze frame
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Rotating videos and images
Nobody likes vertical videos! But don't worry, in just a few clicks, you can turn any photo or video around without having to crane your neck.
 
Rotating by 90 degrees
1. On the Timeline, select the clip you want to rotate
2. Click the Rotate button on the toolbar to rotate the clip by 90 degrees clockwise. Click the button again to rotate the video more.
Learn more: Removing black bars

Fixing the horizon level
1. On the Timeline, select the clip you want to rotate.
2. Click the Crop button on the toolbar to open the Crop tool above.
3. In the Crop tab, use the Angle slider to slightly rotate the clip inside the frame, until the horizon is level with the guides in the player.
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Cropping
Cropping a video can help you remove black bars, cut away the edges of the video, or permanently zoom in onto an object inside the frame.
 
Step 1: On the Timeline, select the clip you want to crop.
 
Step 2: Click the Crop button on the toolbar. The Crop tool will open, and a cropping frame will appear inside the player.

Step 3: In the player, set the frame so that the parts you don't want are outside it. Drag by the corners of the frame to change its size, and drag by the
center of the frame to move it. 

Use the Angle slider in the Crop and Rotate section on the left to rotate the crop frame. This way, you can fix the horizon level.

Step 4: Click Apply. A star  icon will appear on the clip once you've applied cropping.
 

Removing crop

To remove Crop or any other effect, click the star  icon on the clip to show the list of applied effects and filters. In the list, select Crop and click the
Remove button to discard the effect.
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Cropping all clips
Step 1: Open the Edit menu and choose Project Settings to edit your project. The Project Settings window will open.
 
Step 2: In the Resize Method box, choose Crop.
 
Step 3: Click OK. All the project's clips will be automatically cropped to the project's frame size.
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Color adjustments
If the original videos look bleak and not vibrant enough, you can use the automatic adjustments to make the colors look more vivid. If that isn't enough,
you can always use manual adjustments to correct the colors.
 
Step 1: Select clip
On the Timeline, select the clip that you want to adjust.
 
Step 2: Open color adjustments
On the toolbar, click the color adjustments button to open the adjustments tool.

Step 3: Use auto adjustments
Select the adjustment options that make the selected clip look nicer. The changes will be applied instantly. The Magic Enhance option will automatically
determine the best brightness and contrast balance.

Step 4: (Optional) Use manual adjustments
Click the Manual Adjustments button to show more color control options. Here, drag the sliders to fix the brightness, saturation, hue, and other
properties. To go back to the simple options, click the Auto Adjustments button underneath the sliders.

Once you have used the adjustments, the clip will be marked with a star icon, denoting applied tools or filters: 
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Video speed
With the Speed tool, you can speed up or slow down a video or audio clip. This can be useful if you're working on a music video and you want the video to
match the tempo of the music.
 
Step 1: On the Timeline, select the clip you want to edit.
•  Note that slowing down videos works best on videos with a frame rate of 60 FPS (frames per second) and above.
•  You can also change the speed of any audio clip.
•  If you modify the speed of a video with built-in audio, the audio speed will also be changed.
 
Step 2: Click the Clip Properties button to open the editing tools for the selected clip.

Step 3: Drag the Speed slider to set the necessary video speed, where 100% is the video's original speed.

The clip's length on the Timeline will change to reflect the new speed. If you've changed video speed, the video clips will be marked with a star icon:
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Reversing video
Reversing the video will play the clip and its audio backwards. You can combine reversing the video with increasing speed and the VHS filter to create a
cool rewinding effect.
 
Step 1: On the Timeline, select the clip that you want to reverse. You can reverse both video and audio clips.
 
Step 2: On the toolbar, click the Clip Properties button to open the properties for the selected clip.

Step 3: In clip properties, select the Reverse option.

When you apply reverse, the clip will appear with a reverse icon on top of it:



 

104

Image duration
You can change how long each image appears in your video or slideshow either using the clip properties or you can set all images to the same length.
 
Changing one image's length
Step 1: On the Timeline, select the image clip that you want to edit.
 
Step 2: Click the Clip Properties button to open the properties for the selected clip.

Step 3: In the Duration box, enter the new length of the image. Use the following format: hours: minutes:seconds.milliseconds. Changes will be applied
instantly.

You can also change image duration by selecting an image clip on the Timeline and dragging its borders left or right. The longer the clip appears on the
Timeline, the longer it will play in your movie or slideshow.

 
 
Setting the same length for all images
To set all of the project's images to the same length:
 
Step 1: Click the Transition Wizard button on the toolbar.
 
Step 2: In the Transition Wizard window, enter the preferred length into the Image slide duration box. If you don't want to use transitions to join your
clips, select No transitions in the box at the top.
 
Step 3: Click OK to set all the images to the selected length.
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106

Fading video
In the editing tools, you can add smooth fades to the beginning or the end of a clip. For videos and images, you can use fading simultaneously with
animated transitions. For audio clips, you can create a smooth crossfade effect between songs.
 
Step 1: On the Timeline, select the clip that you want to fade.
 
Step 2: Click the Clip Properties button on the toolbar. The clip properties will open in the Tools panel above.

Step 3: Set the fade length using the sliders on the Video tab.
 
Fade in – how long in seconds it will take to fade in to full opacity at the beginning of the clip.
 
Fade out – how long in seconds it will take to fade out from full opacity at the end of the clip.

See also:
Adding transitions
Fading audio
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Creating overlays
How to create picture in picture and split screen effects

Overlays are video or image clips that are shown over the main video. You can use these to create a split screen or picture in picture effect, add a logo or
watermark, create a Chroma Key effect, or insert a short clip without cutting the main video.
 
Before you start:
You'll need to add both the main video (the video that will be the bottom layer) and the overlay video or image to your project.  You can use images in
PNG format to add transparent logos.
 
Step 1: Place the overlay clip
1. Select the clip that you want to make an overlay and drag it up, towards the top of the Timeline.
2. Drop the clip onto the overlay track, where you want it to be shown relative to the main video track.
Note that a blue line now connects the overlay clip to the main clip. This means that the overlay clip is linked to the main clip: if you move, cut, or delete
the main clip, the overlay clip will also be edited.
Hint: you can also layer several overlays at once!

Step 2: Edit the overlay
1. Double-click the overlay clip to set it up. An options panel will appear in the player.
2. Open the drop-down box on the overlay panel and choose how you want it to appear on the video: Picture in picture, Side by side, or Cover.

Picture in picture
This is the default overlay mode. Using picture in picture mode, you can show the overlay video over any part of the screen. This also works for logos.
1. Choose Picture in picture mode from the drop-down box.
2. In the player, move the overlay to where you want it to appear in the frame.
3. To resize the overlay, drag at its corners.
4. Deselecting the Constrain proportions option will allow you to resize the overlay to any proportions, but a drastic change in proportions may make the
overlay look distorted.

Picture in picture overlay
 
Side by side
Side by side mode works best for creating split screens.
1. Choose Side by side mode from the drop-down box.

2. Use the buttons on the panel to choose how you want to align the two videos: 
Hint: for best results, place BOTH sides on the overlay track.
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Side by side overlay
Cover
In Cover mode, the video on the overlay track will cover the main video completely. This can be used for a whole bunch of things:
•  For videos with transparent areas
•  Cutting out the background with the Chroma key effect Learn more: Chroma key 
•  Inserting a short clip over the main video without having to cut it.

Cover overlay: left - the main clip is hidden; right - Cover with the Chroma Key effect
 
Step 3: Apply the changes
After you've set up the overlay, click the Apply button on the overlay options panel.
 
Step 4: Overlay clip properties
In the Tools panel on the left, set up the overlay's properties:

Volume: if you have several video clips playing simultaneously, you might want to mute one of the clips. To do that, click the mute  button, or use the
slider to lower the volume.
 
Opacity: if you want to make the overlay more transparent, lower its opacity, and the main video track will be seen through it.
 
Fade in / Fade out: while you can't use transitions on the overlay track, you can fade in the clip to make it appear smoothly. Set the slider to the time it
should take for the clip to appear.

Awesome, right?
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Adding a watermark
Adding a watermark to your videos will protect your ownership even if it's shared all over the Internet. You can add an image overlay with your own
watermark or logo, or make a new one using text.
 
Image watermark
Step 1: On the Import tab, click Add Media Files and add the image or video that you want to use as the watermark. For the best look, use images with
transparent areas.
 
Step 2: Drag the watermark clip up to the overlay track to make it appear on top of other videos.

Step 3: Double-click the watermark clip to edit the overlay. Move and resize the overlay in the player and then click Apply when you're done.
 
Step 4: To change the opacity, click the Clip Properties button and use the Opacity slider.
 
Step 5: To make the watermark show over the whole length of the video, enter your project length into the Duration box, or drag the right edge of the
overlay clip until the end of the video track.

Text watermark
Step 1: Click the Titles button on the left and pick a nice title style for your watermark.
 
Step 2: Drag the titles you like onto the beginning of the Titles track at the top of the Timeline.

Step 3: Double-click the titles and enter your watermark text. Pick a cool font and color on the panel above the player. Click Apply when you're done.
 
Step 4: To make the watermark show over the whole length of the video, drag the right edge of the text clip until the end of the video track.
HINT: If your movie is long, zoom out on the Timeline to make changing clip length easier.
OR: Double-click the text clip to enter text editing mode and enter the length into the Duration field. You can find the length of your whole project at the
bottom of the window.



 

110



 

111

Creating a freeze frame
A freeze frame is a single frame of a video that repeats for some time, creating an illusion of pausing the video. You can use freeze frames to emphasize a
moment or create a pause to explain things to the viewer.
 
Step 1: Choose a frame
Move the position marker over the frame of the video that you want to freeze. To skip by precisely one frame at a time, use the Previous frame and Next
frame buttons under the player.

Step 2: Create freeze frame
Once you're on the right frame, open the Edit menu or right-click on the clip and choose Insert Freeze Frame from the menu.

Step 3: Set duration
By default, a new freeze frame is four seconds long. To change the duration, drag the edges of the clip to make the clip shorter or longer.
Learn about changing image duration
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Removing black bars
Sometimes, when you use videos of different aspect ratios, or if the project is set up incorrectly, some videos may have black bars around them. You can
remove black bars from videos using one of the ways below.

 
Fill empty spaces
Using a special filter, you can fill the black bars with blurred parts of the video. This allows you to keep the entire video on screen and make it more
pleasant to view.
1. On the Timeline, select the clip with black bars around it.
2. Click the Filters button to open the Filters tab.
3. Find the Vertical video fill filter in the Adjustments group and drag it onto the clip.
Learn more about filters

Manual crop
If black bars appear only on one or several clips, you can cut off the edges to make the video fit better inside the frame.
1. On the Timeline, select the clip with black bars around it.
2. On the toolbar, click the Crop button.
3. A frame will appear in the player. Set this frame on the part of the video that you want to keep. Parts that are outside the frame will be cut off.
4. In the Tools tab on the left, click Apply to accept the changes.
Learn more about crop

 
Automatic crop
If all or most of the clips have black bars around them, you can change the project's settings to either automatically crop all videos or change the project's
proportions.

1. On the bottom panel, click the pencil icon next to Project settings: . The Project Settings window will open.
2. In the Framing box, choose Crop.
Hint: If all of your photos have similar proportions, try using a different resolution.
3. Click OK to accept the changes. The videos will now be automatically cropped.
Learn more about project settings
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Video properties
To open the clip properties for a video or image, select the clip on the Timeline and click the Clip Properties button on the toolbar.

The Tools panel will open on the Video tab, where you can edit the following:
 
Volume — Sets the volume of the clip's built-in audio. Learn more: Volume levels
Only for video clips with built-in audio.
 
Normalize — Makes the quiet parts of the built-in audio louder.
Only for video clips with built-in audio.
 
Speed — Makes the video play faster or slower. Learn more: Video speed
Only for video clips.
 
Reverse — Plays the video backwards. Learn more: Reversing video
Only for video clips.
 
Opacity — Affects the visibility of videos and images on the overlay track. Reduce the clip's opacity to make it more transparent. Learn more: Creating
overlays
Only for clips on the overlay track.
 
Duration — Sets the precise length of the image clip. Learn more: Image duration
Only for images.
 
Fade in — The video fades in from black in the time you set. Any built-in audio will also fade in.
For any clips.
 
Fade out — The video fades out to black in the time you set. Any built-in audio will also fade out. Learn more: Fading video
For any clips.
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Fading effects
Making effects and filters fade in smoothly is possible using the overlay track.
 
Step 1: Copy the clip and paste it onto the Timeline.
 
Step 2: Drag the copy of the clip onto the overlay track above so that it's right above the original. Now you have two identical clips right on top of each
other.

Step 3: Double-click the clip on the overlay track and choose Cover mode in the panel above the player. Click Apply and the clip will cover the entire
frame.

Step 4: Now, apply the effects or filters you want to use onto the upper, visible clip.
Learn more: Applying filters

Step 5: With the overlay clip selected, click the Clip Properties button. There, use the Fade in and Fade out sliders to set the fading time. Here you can
also set Opacity if you want to reduce the effect's strength for the whole clip.
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The clip with the effect will gradually appear and disappear, exposing the underlying original clip.
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Editing audio
Add audio
To add music or other sounds to your project, open the Import tab and click Add Media Files. Or you can use one of the built-in music tracks: click the
Music category and take your pick from our royalty-free music collection.

Learn more about adding audio:
Adding audio files | Recording audio | Extracting audio from video | Using built-in sounds

Volume
To change a video or audio clip's volume, click the Audio Properties button on the toolbar and set the necessary volume in the audio tools section above.

Learn more:
Volume levels | Volume curves | Muting clips

 
Playing audio synchronously
If you want two audio clips to play at the same time, simply drag one clip underneath the other. This way, you can have as many sub-tracks as you want.
With music, you can use this to create a crossfade effect when you join songs: align the beginning of the second song with the end of the first song to make
them joined almost seamlessly.

The end of the first audio clip will be played with the beginning of the second clip.
 
Audio properties and adjustments
To enhance and adjust the audio, click the Audio Properties button on the toolbar and scroll down in the audio tools section above.
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Learn more:
Audio properties | Fading audio | Equalizer | Noise removal | Audio effects | Beat detection
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Adding audio
You can add audio files in much the same way as you add photos and video files.
 
Add files from your hard drive
1. On the Import tab, click Add Media Files to browse for audio files on your computer.
2. A Windows Explorer dialog box will open. Choose the files that you want to use.
3. Click Open. The files will be added onto the audio track of the Timeline.

Use sample audio clips
If you don't have any suitable audio files, you can use free music tracks and sounds from the Movavi Video Editor audio collection.
1. On the Import tab, click Music if you need a background music track, or click Sounds if you need short audio samples. 
2. Click on a clip to play it. When you've picked a clip, drag it onto the audio track of the Timeline.
Learn more about sounds

Record audio
1. Connect a microphone to your computer.
2. On the Timeline, place the position marker to where you want the recording to start.
3. Click the microphone button on the toolbar to open recording options.
4. Set up your recording device and volume.
5. Click Start Recording and record the audio. When you're finished, click Stop Recording. You'll find your new recording on the Timeline.
Learn more about audio recording

Set start time for audio clips
After you've added the audio files, they will appear on the audio track of the Timeline as blue ribbons. To change when the audio clip starts playing, drag it
along the Timeline, using the ruler at the top for time reference. 
Learn about audio tracks
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Extracting audio from videos
If you want to use a soundtrack from a movie, you can extract it from a video file and use it in your project. 
 
Step 1: Open video file
On the Import tab, click Add Media Files and choose the video that contains the music you want. The file will be added to the video track of the
Timeline.

Step 2: Trim video
If you don't need the whole video's soundtrack, you can trim away the parts of the video you won't need. It's easier to do this with the video file, as the
video can help you visually find the beginning and end of the fragment you need.
1. Select the video you want to trim.
2. Move the position marker to the beginning of the fragment you want to keep and click the Split button on the toolbar (scissors). You've just cut off the
beginning of the video. 
3. Now, select the second clip and move the position marker to the end of the fragment you need. Click the Split button again, and the fragment will now
be in a separate clip.
4. If you don't need the other fragments, select them on the Timeline and click the trash can button on the toolbar to delete them.

Step 3: Extract the audio
The audio that belongs to a video is shown right underneath it on the video track. To separate it from the video, drag the audio stripe down onto the audio
track. If you don't need the video clip anymore, go ahead and delete it.

You can now work with the extracted audio clip separately.
 
Step 4: Save the audio (optional)
If you want to save the audio clip for later use, you can export it as an audio file:
1. Click the Export button. The export window will open.
2. In the Export window, switch to the Save Only Audio tab.
3. Select an audio format that you want to save the audio file in.
4. The Save to field shows where on the disk the file will be saved. To change that folder, click Browse and select a new folder.
5. Finally, click Start to save the audio file.
Learn more about saving audio
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Please respect copyright laws and stay within the boundaries of fair use of copyrighted materials.
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Looping audio
If the music file you've selected doesn't go all the way until the end of your movie, you can loop the audio and have the file play over again until the end of
the video.
 
Step 1:  Copy the audio clip. To do that, right-click the audio clip on the Timeline, and choose Copy from the pop-up menu, or use the Ctrl+C keys.
 
Step 2:  Paste the audio clip onto the Timeline right next to the first clip. The clip will be inserted right after the position marker. Repeat until the audio
length is greater or equal to the video length.
 
Step 3: Now, the audio track may be longer than the video track. To trim the audio, hold your mouse pointer over the right edge of the clip, and drag the
edge to the left, until the end of the audio clip is right under the end of the video clip.
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Using sounds
You can make your movies more expressive using the built-in sound samples.
 
Step 1: Click the Import button to open the Import tab.
 
Step 2: On the left part of the Import tab, click Sounds to open the sound collection.

Step 3: Click on a sound to play it and pick a sound you like. Drag the sound onto the audio track of the Timeline.

Step 4: (optional) To synchronize the sound with a video clip:
1. Select the sound on the Timeline and drag it up towards the video track.
2. The linked audio track will appear, and a blue line will connect the sound clip to the video track.
3. Adjust the position of the sound clip on the linked audio track so that the line points to where the sound should begin.
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Volume levels
Changing volume levels works the same way for video and audio clips:
 
Step 1: On the Timeline, select the clip that you want to edit. This can be a video or an audio clip on any track.
 
Step 2: Click the Audio Properties button to open the tools for the selected clip.
 
Step 3: Drag the Volume slider to set the necessary level, where 100% is the original volume.

•  To mute the clip, click the Mute  button on the right.
•  If parts of the audio clip are too quiet, select the Normalize option to increase their volume.

Playback volume
Only for previewing
If you need to temporarily change the volume of playback in the editor, without changing the project's volume, click the speaker icon in the preview area
and set the necessary volume level. Please note that this will only affect the volume while previewing the project in Movavi Video Editor, and will not
affect the output file.

Volume curves
If you need more advanced volume control, you can use volume curves on the Timeline to set the volume for precise parts of any audio clip.
Learn more about volume curves

Audio clip with a volume curve



 

126

Volume curves
With volume curves, you can control the volume for each part of the clip and smoothly increase or decrease the volume.

Each clip has its own volume curve that starts out at 100% volume for the entire clip, and two points at its beginning and at the end. The white line on the
image below is the volume curve before you add any points.

Step 1: Set the base level
Drag the white line up or down to the necessary level. The top of the clip is 100% volume and the middle of the clip is 50%.

Step 2: Add a volume point
Points on the audio curve represent the volume peaks and lows. To add a point, right-click on the audio curve and choose Add Volume Point from the
pop-up menu. Next, drag the audio point to the necessary volume level. You'll notice that the surrounding parts also move with the point to make the
transition smoother.
 
Make as many points as you need for each part of the clip where you'd like a peak or a drop in volume.

Step 3: Manage the volume for a part of the clip
To set the volume level for a part of the clip, you'll need at least two points. Create a point at the beginning and at the end of the fragment:

Click and drag the white line between two points to change the volume level for this fragment. 
 
Step 4: Transitions
When you drag a volume point or a fragment, the parts of the curve to the left and right will also move with it.

However, this affects only the closest parts of the curve. To get more control over the behavior of the curve, create more volume points. This way, only the
adjacent parts will be adjusted, leaving the rest of the curve as it was.
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Linking audio
You can link audio clips to videos or images on the main video track so that they stay in sync as you edit your project. To link an audio clip:
 
1. Select an audio clip on the audio track at the bottom of the Timeline.
 
2. Drag it up, towards the video clip you want to link it with.
 
3. You'll see that a new audio track has appeared, and a blue line now connects the video and audio clips. Drop the audio clip onto this new track. The
audio clip is now linked to the video clip with the blue line.
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Fading audio
In the editing tools, you can add smooth fades to the beginning or the end of a clip and create a crossfade effect between songs.
 
Step 1: On the Timeline, select the clip that you want to fade.
 
Step 2: Click the Audio Properties button on the toolbar. The clip properties will open in the Tools panel above.

Step 3: Set the fade length using the sliders on the Audio tab.
 
Fade in – how long in seconds it will take to fade in from silence to full volume at the beginning of the clip.
 
Fade out – how long in seconds it will take to fade out from full volume to silence at the end of the clip.
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Equalizer
Using the equalizer, you can boost or reduce the levels of specific frequencies.
 
Step 1: Select the audio clip that you want to edit. This can also be a built-in audio clip on the video track.
 
Step 2: Click the Audio Properties button on the toolbar to open the audio tools. There, scroll down in the audio tools and click Equalizer.

Step 3: Choose an equalizer preset (optional)

Step 4: Drag the volume bars to adjust the frequencies to the necessary level.

You can save your own equalizer presets to use them in other projects. Set the volume bars to the right levels and click Save. In the new window enter a
preset name and click OK. The created preset will appear in the presets list.
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Noise removal
Step 1: Select the audio clip that you want to edit. This can also be a built-in audio clip on the video track.
 
Step 2: Click the Audio Properties button on the toolbar to open the audio tools. There, scroll down in the audio tools and click Noise Removal.

Step 3: Use the Noise suppression slider to set the amount of noise you want to remove.
•  Start with low levels and listen to the audio to check if the noise is gone.
•  Don't set the noise suppression too high if there isn't much noise because it can start muting other sounds.
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Audio effects
Audio effects can transform the sound of an audio clip.
 
Step 1: Select the audio clip that you want to edit. This can also be a built-in audio clip on the video track.
 
Step 2: Click the Audio Properties button on the toolbar to open the audio tools. There, scroll down in the audio tools and click Audio Effects.

Step 3: Click the box in the Audio Effects section and choose an audio effect you like.

Removing effects
When you've applied an audio effect to a clip, a star icon will appear on it:

Click on the star to show a list of applied effects. Then, select the effect you don't want and click Remove.

See also:
Using sounds
Audio properties
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Beat detection
To make your movie or slideshow more dynamic, use the Beat Detection audio tool to automatically mark audio beats on the Timeline and then adjust
your movie to the beat of the music.
 
Step 1: On the Timeline, select the music that you want to detect beats for.
 
Step 2:  Click the Audio Properties button to open the audio tools. Then, scroll down and click Beat Detection.

Step 3: In the Beat Detection tool, click Detect Beats. The program will analyze the music and place beat markers on the Timeline.

Step 4: (optional) After the beat markers have been placed, you can modify their tempo. Use the Min time between beat markers slider to make the
beat slower or faster.

Step 5: Adjust your clips to the beat. When you trim or drag clips, they will now snap to the beat markers, making it easy to keep to the beat.
 
Removing beat markers
•  To remove beat markers for a specific audio clip, right-click the clip on the Timeline and select Remove Beats from the pop-up menu.
 
•  To remove all beat markers from your project, right-click the Timeline ruler and select Remove All Beats from the pop-up menu.
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Audio properties
To open the properties for any audio, including built-in audio on the video track, select the clip on the Timeline and click the Audio Properties button on
the toolbar.

The Tools panel will open on the Audio tab, where you can edit the following:
 
Volume — Sets the volume of the clip.
 
Normalize — Makes the quiet parts louder.
 
Speed — Makes the audio play faster or slower.
Changing the speed of built-in audio will also affect its video.
 
Reverse — Plays the audio backwards.
Reversing built-in audio will also reverse the video.
 
Fade in — The audio fades in from complete silence to full volume in the time you set.
Fading built-in audio will also fade the video.
 
Fade out — The audio fades out from full volume to complete silence in the time you set.
Fading built-in audio will also fade the video.

See also:
Video properties
Equalizer
Volume curves
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Filters
Using filters you can alter the mood of the video, make an old movie, overlay cool flying objects, and more.
 
Step 1: Open the Filters tab
Click the Filters button to open the filters collection. Click on a filter's thumbnail to see its preview in the player.

 
Step 2: Find a filter you like
•  On the left, you will see groups of filters. Click on a group to see the relevant filters.
•  If you're looking for a specific filter, enter its name into the search box under the group list.
•  If you really like a filter, click the heart icon to add it to the Favorites group. 

Step 3: Apply the filter
When you've found a filter you like, drag its thumbnail onto the clip you want to apply the filter to.

Once you've applied a filter, a star icon will appear on the clip, denoting applied filters and tools.

Clip with an applied filter
Removing filters
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1. Click on the star  icon on the clip to see the list of applied filters and tools.
2. In the list, select the filter that you don't want.
3. Click Remove.
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Transitions
Jump to: changing transition length | add a transitions to all clips | removing a transition

Transitions are short animations that use geometric shapes and transparency to connect two clips in a creative way.
 
Add a transition
1. Click the Transitions button on the left sidebar to open the list of all transitions. Click on a transition to preview it in the player. 

2. In the list of transitions, pick a style you like and drag-and-drop its icon between two clips on the Timeline. If you really like a transition style, you can

click the heart icon  to add it to your favorites list.

A transition icon will appear between the two clips.

Change transition length
By default, each transition will be set at 2 seconds long. To change the transition length:
1. Double-click a transition on the Timeline to open transition properties.
2. In the Transition Properties window, enter the new transition length in the Duration field. The format is seconds:milliseconds. If you want all
transitions that are currently in the project to have the same length, select the Apply to all transitions option.
3. Click OK to apply the changes.

adding_transitions.htm#transition_length
adding_transitions.htm#transition_allclips
adding_transitions.htm#transition_remove
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Transition mode
In the Transition Properties window you can choose mode of transition. This setting affects what media is used to fill in the missing parts of the
transition:
 
Trimmed content – if you've trimmed the video, the trimmed bits will appear during the transition. If the videos haven't been trimmed, a freeze frame is
shown.
Freeze frame – a static frame is shown during the transition.
Slow motion – the part of the video overlapped by the transition is stretched to fill the entire duration.
 
The default mode is set to Trimmed content. The change of transition mode is more obvious when applied to a video clip rather than to an image.
 
Add transitions to all clips
Using the Transition Wizard
You can automatically add transitions between all clips in your movie in just a few steps:

1. Click the slideshow  button on the toolbar. The Create Slideshow dialog box will open.
 
2. In the Create Slideshow dialog box, select a transition style that you want to use for all clips. If you want to use different transitions, choose the Use
random transitions option in the list of transitions.
 
3. In the Transition duration box, enter the length that you want to set for all transitions. A transition cannot be longer than the shortest clip in your
project.
 
4. Click OK to accept the changes.
 

Using the right-click menu
To add one transition to all the clips in your project, right-click the transition's thumbnail and choose Add to All Clips from the pop-up menu.
 
Remove a transition
To remove a transition from your movie or slideshow, right-click the transition on the Timeline and choose Remove Transition from the pop-up menu. If
you want to delete all the transitions in your project, choose Remove All Transitions.
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Titles
How to add text to your videos

Adding text titles to your movie allows you to express your thoughts and supplement the audio with subtitles.
 
Step 1: Go to the Titles tab
On the left-hand side of the window, click the Titles button to view the titles collection.
•  Click on a title style's thumbnail to preview its looks in the player and choose the titles you want to use.

•  If you really like a title style, click the heart icon  on its thumbnail to add it to your favorites list.

Step 2: Add a title clip
To add titles to your project, pick a title style you like and drag its thumbnail onto the title track of the Timeline, right above the video track, onto the time
where you want them to appear. The title clip will appear as a purple ribbon on the Timeline.
 
Note the purple line connecting the beginning of each title clip to a corresponding video clip on the video track. This way, whenever you move or edit the
video clip, its titles will always stay in sync.

To make several text clips appear simultaneously, simply place them one on top of another on the titles track.
 
Step 3: Edit titles
When you've added a title clip, it will start out with the default text and looks. Double-click the title's ribbon on the Timeline to show editing options in the
player.
 
Title clip properties

Click the cogwheel icon  at the top of the editing panel to see title clip properties. Here, you can change the duration of the titles and animation
speed (how fast they will appear or disappear).
 
Editing text
1. In the preview, double-click on the text box you want to edit.
 
2. Enter the new text.

3. Click the Font properties  button and select the font style, size, and alignment options for the selected text.

4. Click the Color properties  button and choose a color for the text, and the outline's width and color.
 
5. Drag the text box to where you want to see it on the video.
 
Editing decoration elements
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Some titles come with frames, ribbons, and other decorations. To change their color, select the decoration element you want to edit and click the Color

properties  button. Then, click the Decorations color palette and choose the new color.
 
Finally, click Apply to exit editing mode.

See also:
Adding callouts
Adding a timer
Timeline tracks
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Adding a timer
Step 1: Open the Titles tab
Click the Titles button on the left sidebar to open the list of available text styles.

Step 2: Add Timer titles
1. Find the "Timer" title style. Use the search bar or click the Basic group to filter the styles.
2. Drag the Timer titles onto the title track of the Timeline. Move the clip along the Timeline until its beginning is where the titles should appear. To
change the length of the timer, drag at the edges of the clip.

Step 3: Edit the timer
1. Double-click the timer clip on the Timeline to edit it. A properties panel will appear over the player.

2. On the Clip properties tab , set the duration and the format of the timer. The format determines which units of time are visible on the timer: hours
(hh), minutes (mm), seconds (ss), and milliseconds (zzz).

3. On the Font properties tab , choose the font and style of the numbers.

4. On the Color properties tab , set the color of the numbers and the background color. To make the background transparent, click the background
color square and set Opacity to 0%.

5. On the Timer tab , enter the starting time into the From box. If you want the timer to count backwards, select the Countdown option.
 
6. In the player, drag the Timer to the necessary location on screen.
 
7. Finally, click Apply to exit editing mode.
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Saving custom titles
After you've set up titles to look the way you want, you can save that style and use it in your projects.
 
Step 1: Just like you usually edit titles, double-click the title clip and choose the font, color, and other options.
 
Step 2: Click the Save icon at the top of the title editing panel on top of the player.
 
Step 3: Enter a name for your titles and click Save.
 
The new title style will appear under the My titles group.
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Stickers
You can decorate your video and make it more fun by adding stickers on top of it.
 

Step 1: Open the Sticker collection
Click the Stickers button in the sidebar to open the list of stickers.
•  Click on a sticker's thumbnail to preview it in the player

•  If you really like a sticker, you can click the heart icon  on its thumbnail to add it to your favorites list.
Hint: if you don't see the Stickers button in the sidebar, click the More button at the bottom of the sidebar and select Stickers from the pop-up list.

Step 2: Add the sticker
Select the sticker's thumbnail and drag it onto the title track of the Timeline. All titles, callouts, and stickers go on the title track.

Step 3: Edit the sticker
Change length
To change how long a sticker appears on the video, drag the edges of the sticker clip on the Timeline.

Move the sticker
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To change the sticker's position on your video, double-click the sticker clip to go into editing mode. In the player, drag by the corner of the frame around
the sticker to change its size, and drag by the center of the frame to move the sticker. To rotate the sticker, click and drag the white dot at the top of the
frame. Click Apply above the player when you're finished.

Frequently asked questions
Can I apply transitions to stickers?
No, you can't. Stickers always appear instantly on top of the video.
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Callouts
Using callouts, you can annotate your video with arrows, icons, and other shapes.

Step 1: Open the Callouts tab
Click the Callouts button on the left sidebar to open the shape collection. To preview a callout style, click on its thumbnail.
•  Callouts are grouped into categories on the left. Use these to find the shapes you need.
•  If you're looking for a specific callout, type its name into the search box under the list of groups.

•  If you really like a callout style, click the heart icon  on its thumbnail to add it to your favorites list.
Hint: if you can't see the Callouts button, click the More button at the bottom of the sidebar and choose Callouts from the pop-up list.

Step 2: Add callout clip
When you find a style you like, drag it onto the title track at the very top of the Timeline. Place the beginning of the clip where you want the callout to start
appearing. Drag the edges of the callout clip to change its duration.

Note that the clip is linked to the corresponding clip on the main video track with a purple line. This means that the callout clip is synchronized with the
video: when you move or cut the video clip, the callout clip will follow without losing sync.
 
Step 3: Edit the callout
Double-click the callout clip. An editing panel will appear in the player. If the callout consists of several elements, for example, text and a shape or two
shapes, make sure to select the one you want to edit.

 
Position
In the player, drag the callout to where you want it to appear on screen.
 
Clip properties
•  On the editing panel, set the animation speed for the element to change how fast it appears on screen.
•  To change the callout's duration, enter it into the Duration box or drag the edge of the callout clip on the Timeline.
 
Colors
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Click the Color properties icon  and choose the color and outline for the selected element.
 
Text
•  If the callout has text, double-click on the text box and enter the new text.

• 
 
Click the Text properties icon  and choose the new font, size and style for the callout text.

 
When you're done, click Apply to accept the changes and exit editing mode.

See also:
Timeline tracks
Adding titles
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Pan and zoom
Using the Pan and Zoom tool, you can control camera movement using two keyframes. Set the beginning zoom and the end zoom using the frames in the
player, and the camera will smoothly move from one frame to the other.
 
Step 1: Open the Pan and Zoom tool
1. On the Timeline, select the clip that you want to zoom.
2. On the left sidebar, click the Pan and Zoom button.
Tip: If you can't see Pan and Zoom button, maximize the window, or click the More button at the bottom and select Pan and Zoom from the pop-up list.

Step 2: Add pan or zoom keyframes
1. On the Timeline, place the position marker to where you want the zooming to begin.
2. Select one of the zooming methods: Zoom in, Zoom out, or Pan.
Tip: To see how an effect works, select it and click Preview.
3. Click Add.

This will add two zoom keyframes to the clip. Using these keyframes, you can set up when the camera moves from one point to the other. The camera will
move between these two keyframes.

Step 3: Set up the zoom frames
Now, you can set the zoom level for each keyframe using the frame in the player, and the camera will smoothly move from one frame to the other.
 
1. To change the starting keyframe, double-click the first point on the clip. Then, use the frame in the player to set the zoom level for the starting point of
the camera movement. 
 
2. To change the ending keyframe, double-click the second point on the clip. Then, use the frame in the player to set the zoom level for the ending point of
the camera movement.
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Step 4: Change the keyframe time
•  To change the length of the zoom effect, hold your mouse pointer over a keyframe and move it left or right.
 
•  To move the zooming effect without changing its length or other settings, hold your mouse pointer over the arrow and move it along the clip.
 
Step 5: Add more zooming (optional)
If you want to add more camera movements, repeat steps 2-4 to combine other camera movements in one clip. For example, you can zoom in on an object,
pan across the frame with the same zoom level, and then zoom back out to 100%.

 
Removing zoom
To remove a pan or zoom effect, right-click a keyframe and select Remove All Keyframes to clear all zoom effects from the clip. To remove just the
selected keyframe, select Remove Keyframe.
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Stabilizing video
If you're filming with a handheld camera, it's likely that there might be some unwanted camera shake visible on the video, especially if you walk or move
while filming.
 
Step 1: On the Timeline, select the clip you need to stabilize. Longer videos take more time to stabilize, so you may want to first cut the video into
smaller segments.
 
Step 2: On the left sidebar, click the Stabilization button.
Tip: if you don't see the Stabilization button, click the More button and select Stabilization from the pop-up list.

Step 3: Click Stabilize to open stabilization options. The Stabilization window will open.

Step 4: Set up stabilization with the following parameters depending on the video and the amount of shaking:
 
Accuracy: affects the analysis precision of the video. Higher accuracy yields the best results, but also takes more time.
 
Shaking: set how strongly the shaking is visible on the video.
 
If you need more advanced settings, click the arrow under the sliders.
 
Radius: when a video is stabilized, each object is adjusted using the pixels from the surrounding area. The radius affects how large that area will be. Use a
smaller value for more dynamic videos to avoid mixing objects together and to preserve more detail.
 
Smoothing: limits camera acceleration. Higher values work best for more or less static videos. Excessive smoothing may limit panning.
 
Edge Cropping: after compensating for motion, some distortion artefacts like blurred areas may appear around the edges.

•  None: the edges will remain as they are. Best results if there is little shaking on the video.
•  Fixed: the video is cropped to one size to cut off some of the edges.
•  Adaptive: whenever there is a lot of shaking, the video will zoom in so that the distorted edges are not shown.
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Step 5: Click Stabilize to start processing the video. This may take a while depending on the length of your video and the selected parameters.

Step 6: After the video has been stabilized, you will see its preview in the player. If you're satisfied with the result, click Apply to replace the clip on the
Timeline with the stabilized video. If you didn't like the results, repeat steps 4 and 5.
 
Stabilized copies
A stabilized copy of the file will be created under "\My Videos\Movavi Screen Capture Studio\Stabilized". This copy will be used in the project instead of
the original video. If you delete the stabilized copy, it will be replaced with the original video, and you will need to stabilize the clip again.
 
Filming tips
•  When shooting videos, try to rest the camera on something.
•  If possible, use a tripod. Some tripods are really small and can fit into your bag.
•  If you can't put down the camera, hold it with both hands and close to your body. This will minimize the shaking.
•  Try to move around less. If you have to move the camera, do it slowly.
•  Check your camera's settings to see if it has built-in stabilization.
 

Troubleshooting
Not enough disk space error
When a video is stabilized, the Video Editor creates a stabilized copy of the video in a folder on your disk. By default, this folder is "\My Videos\Movavi
Screen Capture Studio\Stabilized" on your main disk drive. If you are running out of space on that drive, you can either free more space and try again, or
tell the program to save stabilized copies on another disk: 
1. Open the Settings menu and choose Preferences.
2. Switch to the Files tab.

3. Find the "Store stabilized videos in" box and click the button  on the right to choose a different folder on a drive where you have more space.
4. Click OK to accept the changes. Now, try stabilizing the video again. 
 
Cannot access folder error
This error means that you've changed the folder where stabilized files are stored, and that folder's permissions prevent Video Editor from creating files
inside it. Try using a different folder for storing stabilized videos.
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Highlight and conceal
Using the Highlight and Conceal tool, you can control the focus in the frame, and blur or darken parts of the video.

Step 1: Open the Highlight and Conceal tool
1. On the Timeline, select the clip that you want to edit.
2. On the left sidebar, click the Highlight and Conceal button. The tool's options will open, and a frame will appear in the player.
Tip: If you don't see Highlight and Conceal button, click the More button at the bottom, and choose Highlight and Conceal from the pop-up list.

Step 2: Set up the mask
1. In the Highlight and Conceal tool, open the box and choose Conceal if you want to hide an object, and Highlight if you want to bring attention to the
object.

2. Choose a shape for the mask: you can use a rectangle or an ellipse.
 
3. Choose a masking effect: blur, matte (black cover-up) or pixels. Use the options below to fine-tune the mask:
•  Opacity – makes the mask more transparent (for matte and blur)
•  Feathering – makes the edges of the mask softer (for matte and blur)
•  Size – changes the size of the pixels (for pixel masks only)
•  Outline – adds a white outline around the mask.

4. In the player, drag the corners of the mask to change its size and shape, and drag by the center of the mask to move it on top of the object.
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Step 3: Add more masks (optional)
If you want to cover up or highlight more than one object, click Add Mask above the player to create another mask, and you can now set it up the same
way as the first. The selected mask is highlighted orange in the player.

Step 4: Apply the changes
When you're done, click Apply on the Highlight and Conceal panel to finalize the changes.
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Chroma key
How to replace a video's background

The Chroma key effect allows you to remove any color from the image or video, leaving the background transparent.
 
Step 1: Add the foreground and background clips
Add the video or image clips that you want to use as the foreground and the background. For the foreground (the clip that you want to remove the
background from), use a clip with a bright, solid background that contrasts with the foreground objects.
 
Step 2: Create an overlay
1. Select the foreground video and move it up, onto the Overlay track.
2. Double-click the foreground video on the Overlay track. The overlay options will appear above the player.
3. To make the foreground video completely cover the background video, select the Cover overlay mode from the list above the player.
4. Click Apply.

Step 3: Open the Chroma Key tool
1. Select the foreground video on the Overlay track.
2. On the left sidebar, click the Chroma Key button. The Chroma Key options will appear.
Tip: If you don't see the Chroma Key button, click the More button and select Chroma Key in the pop-up list.

Step 4: Set up Chroma Key
1. Once you open the Chroma Key tool, move your mouse cursor over the player and click on the color that you want to remove. The color you've picked
will be made transparent, and the underlying video will now be visible.
Tip: if nothing happens when you click on the player, click the color swatch in the Chroma Key options and then try again.

2. Use the Tolerance slider to set how many similar shades of the selected color should also be removed. Higher values will remove similar colors to the
one you've selected.
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3. Use the Noise slider to determine how sharp the object's edges should be.
4. Use the Edges slider to determine how thick the object's edges should be.
5. Use the Opacity slider to set the transparency of the background.
6. Finally, click Apply to accept the changes.

Cropping the video
If the videos you're using for the foreground and background have different aspect ratios, you may end up with black bars or empty areas along the edges
after applying Chroma key. To fix this, crop the videos to the project's aspect ratio.
How to remove black bars
Cropping videos
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Exporting videos
When you're done with your project, you'll need to export it as a media file to be able to play it back in media players, mobile devices, and so on. This
section will guide you through the process of exporting your project to a popular video format. If you want to find out more about other ways of saving
videos, see the following guides:
Saving only audio
Saving videos for devices
Saving videos for TVs
Uploading videos online
 
Step 1: Open the Export window
To start saving the video, click the Export button in the bottom right-hand corner of the Editor. The export settings window will open.

Step 2: Choose a format
In the new window choose a format for saving the video in.  Some formats allow you to choose between video codecs. If you don't know which format to
choose, try using MP4 with the H.264 codec. The MP4 format is supported by most platforms and operating systems.
The Estimated File Size field shows how much disc space your file will require after saving. If the file size is too large, you can set a lower resolution in
the Project Settings. At lower resolutions, the file will be significantly smaller, however, the video will lose some quality due to the limitations of digital
data compression. When changing resolutions, we recommend that you keep the same aspect ratio to avoid black bars around the video or other unwanted
distortions.
The GIF format is different from other formats in the list. It allows saving video as a mute animated image, which can then be played in some image
viewing programs or in any web browser.
Learn more about project settings 

Step 3: Check your project settings
When saving standard video, the video will be exported with the same settings that were set for the project. This way, the output video will appear exactly
as you've seen it in the preview area. If you want to change the resolution, aspect ratio, or other settings, click the Advanced button to view and edit the
project settings. In the settings you can also choose to save a 60 FPS video*.
*The video file will have a frame rate of 60 FPS only if the original video files used in the projects had a frame rate of 60 FPS and above.
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Step 4: Select quality (optional)
If your project is heavy on small details and filters, you can select High or Highest quality to export the finished video with a higher bitrate. This will
increase the output file size but will preserve better quality. For most other projects, Good quality will provide a nice result at a small file size.

Step 5: Choose a destination folder
Name your file and choose a destination folder.
In the 'Save to' field, enter the folder where you would like to store the file. By default, this will be the directory for saving output videos specified in the
preferences. To set a different folder, click the Browse button and choose the folder in the Windows Explorer window, or enter the path manually into the
box. Name your video in the File Name field: the project's name will be filled in for you by default.

Step 6: Start exporting
Click the Start button to begin processing the video file. This may take up to a few minutes.



 

158

Export only audio
This section will guide you through exporting just the audio track of your project.
 
Step 1: Open the Export window
Click the Export button in the bottom right-hand corner of the Editor to open the export settings window.

Step 2: Switch to the Save Audio File tab
In the left hand part of the Export window you will find a number of tabs. Click on the Save Audio File tab.

Step 3: Choose a format
Select the format you'd like to save the audio in.

While MP3 is the most commonplace format, supported by almost all media players and devices, FLAC format allows you to preserve high audio
quality, albeit taking up considerably more disc space. When choosing an output format, it is important to note the quality of the original files: due to data
compression limitations, digital audio cannot be restructured from very low quality files by saving them as FLAC audio, and vice versa – high quality files
may lose some of that quality when saved to MP3 format which is limited to 320 Kbps.
 
When saving audio from your project, the audio file will retain the same sample rate and channel settings as you have set for your project. The audio bitrate
will be determined from the quality of the original files and from the maximum bitrate for the selected format (for example, MP3 is limited to 320 Kbps,
while FLAC bitrate is not limited).
 
Step 4: Name your file and choose a destination folder
In the 'Save to' field, enter the folder where you would like to store the file. By default, this will be the directory for saving output videos specified in the
preferences. To set a different folder, click the Browse button and choose the folder in the Windows Explorer window, or enter the path manually into the
box. Name your video in the File Name field: the project's name will be filled in for you by default.
 
Step 5: Start exporting
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Click the Start button to begin processing the video file. This may take up to a few minutes. 
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Export for devices
This guide will help you export your video project for playing on mobile phones, tablets, and other devices.
 
Step 1: Open the Export window
In the bottom right hand corner of the Editor, click the Export button to open the export settings window.

Step 2: Switch to the Save for Devices tab
In the left hand part of the Export window click on the Save for Devices tab.

Step 3: Choose a format
On this tab you will find a number of different types of devices for which you can choose a format. You can choose between devices running iOS (iPhone,
iPad, iPad mini) or Android, Samsung Galaxy S6 and Galaxy S7, Google Nexus 6 and Google Pixel, as well as Playstation and Xbox consoles. If your
device is not on the list, choose Other.

Step 4: Set export quality (optional)
If your project is heavy on small details and filters, you can select High or Highest quality to export the finished video with a higher bitrate. This will
increase the output file size but will preserve better quality. For most other projects, Good quality will provide a nice result at a small file size.
In the Advanced section you can view the properties for the output file. Due to the limitations of some devices, the video resolution, audio quality, and
other properties may be changed to adhere to the requirements of the selected device. Estimated File Size will give you a rough estimate of how much
disk space the file will occupy, which may be important if your device is running out of memory.
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Step 5: Name your file and choose a destination folder
In the 'Save to' field, enter the folder where you would like to store the file. By default, this will be the directory for saving output videos specified in the
preferences. To set a different folder, click the Browse button and choose the folder in the Windows Explorer window, or enter the path manually into the
box. Name your video in the File Name field: the project's name will be filled in for you by default.
 
Step 6: Start exporting
Click the Start button to begin processing the video file. This may take up to a few minutes.
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Export for TVs
This guide will help you export your video project for playing on Smart TVs.
 
Step 1: Open the Export window
In the bottom right hand corner of the Editor, click the Export button to open the export settings window.

Step 2: Switch to the Save for TVs tab
In the left hand part of the Export window click on the Save for TVs tab.

Step 3: Choose a format
Choose your TV brand and the necessary resolution. If your TV is not on the list, choose Other 1080p TVs or Other 4K TVs.

Step 4: Set export quality (optional)
Project settings: If you've been using the default project settings, your video's resolution is now 720p. To avoid losing quality when saving to a larger
resolution, open the Advanced window and edit the project settings. There, choose the 1920x1080 resolution for 1080p HDTVs, and the 3840x2160
resolution for 4K Ultra HD TVs.
 
Quality: If your project is heavy on small details and filters, you can select High or Highest quality to export the finished video with a higher bitrate. This
will increase the output file size but will preserve better quality. For most other projects, Good quality will provide a nice result at a small file size.
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Step 5: Name your file and choose a destination folder
In the 'Save to' field, enter the folder where you would like to store the file. By default, this will be the directory for saving output videos specified in the
preferences. To set a different folder, click the Browse button and choose the folder in the Windows Explorer window, or enter the path manually into the
box. Name your video in the File Name field: the project's name will be filled in for you by default.
 
Step 6: Start exporting
Click the Start button to begin processing the video file. This may take up to a few minutes.
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Uploading to the Internet
After you finish your video, you can share it to YouTube or Google Drive right from the export window.
 
Step 1: Open the Export window
Click the Export button to open the exporting window.

Step 2: Switch to the Upload online tab
In the left hand part of the Export window click on the Upload to Youtube tab.

Step 3: Choose a service to upload to
On the Upload online tab select the service you would like to upload your videos to: YouTube or Google Drive.

 
Step 4: Sign in to your account
1. Click Sign in. The authentication page will open in your browser.
2. Sign in to your account and click Allow to let Movavi Video Editor upload videos.
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Step 5: Choose a resolution
In the Export window, open the Resolution list and choose a resolution that suits your project.
•  For best results, choose a resolution that is equal to or less than the height of your project. You can find the resolution of the project at the bottom of the
main window, next to Project settings. For example, if your project is 1280x720, choose the 720p resolution.
•  This resolution will be the highest quality available for your video. Lower resolutions will be generated automatically by the website.

Step 6: Fill in the details (YouTube)
1. Fill in the title and description for your video.
2. Add some tags to help users find videos by relevant topics. Separate tags with commas and add a number sign (#) before each one.
3. Choose a category to help viewers find relevant content.
4. Open the Privacy box and choose who you want to see the video:
•  Private – videos can only be seen by you and the users you choose.
•  Public – videos can be seen by and shared with anyone.
•  Unlisted – videos can be seen and shared by anyone with the link.

Step 6: Fill in the details (Google Drive)
1. Fill in the title for your video.
2. Select a Google Drive folder where you want your video to be uploaded. You can create new folders in your Google Drive storage straight in the export
window.
3. Open the Privacy box and choose who you want to see the video:
•  Private – videos can only be seen by you and the users you choose.
•  Unlisted – videos can be seen and shared by anyone with the link.
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Step 7: Save and upload the video
1. Before uploading, the video will be saved as a file on your computer. To change where the video file is stored, click Browse and select a folder.
2. Click Start to begin saving and uploading the video.
 
*YouTube allows users to upload videos up to 15 minutes. To upload longer videos, you need to verify your account.
YouTube help – increasing your upload limit 

 
See also:
Sharing preferences

https://support.google.com/youtube/answer/71673?hl=en
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Video Editor preferences
To open the preferences:
1. Click the Settings menu
2. Select Preferences.
 
The Preferences window will open. The preferences are organized into tabs. Click on a tab to open the relevant options.

When you're done, click OK to close the window and apply the preferences.

See also:
General preferences
File preferences
Acceleration preferences
Sharing preferences
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General preferences
Interface Language – to change the interface language, simply select the necessary language from the list and click OK to apply the changes.
 
Automatically check for updates – select this option and you'll be notified whenever a new version is available. Updates within your version are
absolutely free (e.g. 1.0 to 1.1), while new releases are offered with a hefty discount to registered users.
 
Show startup window when creating new project – with this option enabled, you will be prompted to select settings for the new project on startup and
when creating new projects. You can choose the project's aspect ratio and other settings, as well as open an existing project.
 
Send anonymous usage stats to Movavi – checking this box will allow the program to send usage statistics to our development team, enabling us to fix
any bugs you may encounter much faster, as well as add new features that you might be missing. The data contains no personal information, will not be
disclosed to third parties and will be used for software improvement purposes only.
Learn more about how we use the statistics
Read our Privacy Policy
 
Use software OpenGL implementation – this option can be useful if your computer doesn't support the necessary OpenGL version and you see an error
message when you start the program.
 
OpenGL is a software interface that manages graphics output. Usually, OpenGL is handled by your graphics card driver. However, some graphics cards do
not support the necessary version of OpenGL. For these graphics cards, you can use this option to download and install a software replacement. Installation
will run automatically, but you will need an Internet connection to download the files.
 
If Movavi Video Editor runs without showing an OpenGL error message, this option is not recommended.
Learn more about OpenGL troubleshooting
 
Play notification sound when exporting is finished – when saving a project as a media file, you'll be notified as soon as the process is completed.

http://www.movavi.com/mip.html
http://www.movavi.com/privacy.html
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File preferences
On the Files tab, you can find the options for storing and saving different kinds of files. You can change any of these folders to a different location.

 
Save project files to – this folder will by offered by default when saving and opening projects. This folder will also store any autosave files for new
projects. You can use the autosave file to restore your work in case of an error or force close.
 
Save output videos to – this folder will be offered by default when exporting media files.
 
Store audio recordings in – the audio clips that you record in the Editor will be stored as audio files in this folder. Tip: if you delete these audio files, the
audio recordings in the project will also be unavailable.
 
Store stabilized videos in – when you stabilize a video, a stabilized copy of the original will be created in this folder and used instead of the original. Tip:
don't delete these files while you are working on the project, or you'll have to stabilize the files again.

Changing where the files are stored
Using a different folder might help if you don't have much disk space on your primary drive, or if you want to organize your media files in another way.

1. Click the button with three dots  next to the folder you want to change.
 
2. A Windows Explorer dialog box will open. Choose the folder you want to save the files to.
 
3. Click Select Folder to use this folder. 
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Acceleration preferences
If your computer is equipped with the necessary hardware, these options can help speed up encoding and decoding of media files, allowing you to save
your movies much faster and enjoy smoother performance.

Enable Intel hardware acceleration
•  Accelerates video processing by up to 400% when working with H.264 and MPEG-2 video codecs.
•  This option is only available if your computer is equipped with an Intel processor that supports the Intel HD Graphics™ technology.
 
Enable NVENC hardware acceleration
•  With this option enabled, your NVIDIA graphics card will be used for processing H.264 and MPEG-2 videos and they will be saved up to 50% faster.
•  Because video processing is carried out by the graphics card, your CPU is free for other tasks, ensuring smoother performance in other programs.
•  This option is only available if your computer is equipped with an NVIDIA graphics card that supports this technology.
 
Troubleshooting
If acceleration options are unavailable:
•  Your computer might not have the right hardware.
•  If you're sure that your hardware meets the requirements, try updating your drivers. You can always find the newest version on the manufacturer's
website: Intel Download Center | NVIDIA Driver Downloads

Intel HD Graphics is a trademark of Intel Corporation.
NVENC is a trademark of NVIDIA Corporation.
 

https://downloadcenter.intel.com/
http://www.nvidia.com/Download/index.aspx?lang=en-us
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Sharing preferences
On the Sharing tab of the Preferences window, you can manage your social network accounts for uploading videos.
 
To sign in:
1. Click Sign In. The authentication page will open in the browser.

2. Sign in to your account.
3. On the next page, allow Movavi Video Editor to upload videos to your account.

4. Return to the Video Editor. Your name will be shown in the Preferences window.
 
To sign out or use a different account:
Click Sign Out. After this, you will need to sign in again to upload videos.
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Capture audio
Step 1: Connect a microphone
Connect a microphone to your computer and make sure that it is recognized by the system.
 
Step 2: Open the audio recording module
Open the Movavi Screen Capture Studio launcher and click Record audio. The audio recording module will open in a separate window.

Step 3: Set up audio capture
In the Audio capture device box, choose the microphone or whichever device you want to use for recording sound. To record audio that is playing on
your computer*, choose 'Stereo Mix' or 'Speakers'.
* Depending on the model of your audio card, this option may be named differently. Some device manufacturers do not include a system audio recording
option.
 
In the Saving captured files section, you can choose a template for naming the captured files. To do that, open the File renaming box and choose date or
free text. Then, fill in the template details and the recordings will all be named after this template.
 
Under Save files to, specify the folder where you want to save the recordings. Click the folder icon next to the box to browse for the folder you need.

Step 4: Record
Click Start Capture to begin recording. As you record sound, you can see the frequencies reflected as color bars in the center. When you're done, click
Stop Capture. If you need to record more audio clips, simply repeat this step.
 
The audio files will be saved to the folder specified in the 'Save files to' box. To open this folder, click the View saved files button. 
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Capture webcam
Follow the steps below to record video from a camera that's connected to your computer.
 
Step 1: Connect the camera you want to capture from to the computer. Make sure that the system recognizes the device and that it is working correctly.
 
Step 2: Open the Movavi Screen Capture Studio launcher window and click Record webcam.

 
Step 3: In the Video capture device box, choose the camera you want to use for capture. Then, select the resolution and frame rate. A larger resolution
will be able to retain better quality, however, the video file size will be larger. A higher frame rate is necessary for recording motion, while static scenes
can be captured with a lower frame rate.
 
Step 4: In the Audio capture device box, choose the microphone that you want to record the sound with.

Step 5: (optional) By default, the recordings will be saved to your Movavi Library folder. If you want to save them somewhere else, click the folder

button  under 'Save files to' and choose a different location.
 
Step 6: (optional) If you want to batch rename the files, choose a renaming option from the 'File renaming' box and set up the new file name template. 
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Step 7: Click Start Capture to begin recording the video. During capture, you can take snapshots using the camera button  on the right.
 
Step 8: To finish the recording, click Stop Capture. If you need to record more videos, repeat steps 7 and 8.
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Help and support
Didn't find what you were looking for? Need help with a problem? Have a suggestion? Contact our support team and we'll help you right away.

How to reach us
By e-mail: support@movavi.com
Fill out a support form
We guarantee a response within 3 business days!
 
If you ran into a problem, please describe it in as much detail as possible; any screenshots, log files, or information about your
system will allow us to help you faster.

Frequently asked questions
 
Why is "Trial Version" written on my videos?
The watermark is only placed on videos in the trial version. Buy an activation key and use it to activate the program. After that, you can convert files
without the watermark.
Removing trial restrictions
 
Why do I have to activate codecs?
Some video and audio codecs are patented by other organizations and need to be activated. Activation is free of charge and you will only need to do this
once for each patented codec. You may encounter the activation messages when starting capture or opening captured files. When you activate the codec,
the program sends your consent to our server. If you don't want to see these messages, select Activate other codecs without asking, and future codecs will
be activated automatically.
Codec activation
 
 

mailto:support@movavi.com
https://www.movavi.com/support/contact.html
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System requirements
 Minimum system requirements Recommended configuration

Operating system Windows® XP*/Vista/7/8/10 with latest service packs and patches

Processor Intel®, AMD® or compatible processor, 1.5
GHz

2.8 GHz or higher multi-core processor

Resolution 1024x768, 32-bit color 1280x1024 or higher

RAM Windows XP, Vista – 512 MB
Windows 7, 8, 10 – 1 GB

Windows XP – 2 GB
Windows Vista, 7,8, 10 – 4 GB

Available disk space 810 MB for installation
2 GB for ongoing operations**

10 GB for recording and media processing

 Administrator permissions are required for installation

Additional features  Sound card for audio recording and playback

  Intel® hardware acceleration requires a compatible
Intel processor supporting Intel HD Graphics™ 2nd
generation or higher

  For intended performance, make sure that your
graphics card drivers are up-to-date.
Updating graphics card drivers

* Windows XP does not support recording system sound simultaneously with audio devices.
** Free disk space is required to save the temporary recording file and the output video. The required amount of disk space will depend on the resolution,
format, and length of your videos.
 
 
Movavi Screen Capture Studio may also run on slower machines, however, we cannot guarantee stable performance if the minimum requirements are not
met.
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Supported formats
 Screen Recorder supports the following formats and codecs:

Video Formats Supported Codecs

Audio Video Interleave (.avi) H.264, MPEG-4, MJPEG

QuickTime (.mov) H.264, MPEG-4, MJPEG

MPEG-4 (.mp4) MPEG-4, H.264

Audio Formats Supported Codecs

MP3 – MPEG-1/2 Audio Layer III (.mp3) MP3

  Image formats

BMP, JPEG, PNG, GIF
 
Here you can view the list of formats and codecs supported by Video Editor.
 

Video Formats

Format Codec Read Write

3GPP, 3GP2
(*.3gp, *.3g2)

H.263

 H.264, MPEG-4  

ASF – Advanced Streaming Format
(*.asf)

MPEG-4, VC-1, WMV V7  

AVI – Audio Video Interleave
(*.avi)

H.264, MPEG-4

 H.263, MJPEG, DivX, Xvid, DV,
Cinepack, Fraps, TechSmith,
Uncompressed

 

DivX Video
(*.divx)

DivX  

Flash Video
(*.flv)

H.264

 FLV1, H.263, Flash Screen Video  

Flash Video
(*.swf)

FLV1

 MJPEG  

MKV – Matroska
(*.mkv)

H.264, MJPEG  

 MPEG-4, Theora, DV, Uncompressed  

M2TS – MPEG Transport Stream
(*.m2ts)

H.264

MTS – MPEG Transport Steram
(*.ts, *.mts, *.m2t)

MPEG-2, H.264  

MPEG
(*.mpg)

MPEG-1, MPEG-2

MPEG
(*.mpeg, *.mpe, *.m1v, *.mod, *.tod)

MPEG-1, MPEG-2, H.264  

MPEG-4
(*.mp4)

MPEG-4, H.264

 H.265*
* supported on Windows 10 only

 

 H.263, MJPEG, ProRes  

MPEG-4
(*.m4v)

MPEG-4, H.264, H.263, MJPEG, ProRes  

MXF – Material eXchange Format
(*.mxf)

MPEG-2, DV  

OGV – Ogg Video
(*.ogv)

Theora

 MPEG-4  

MOV – QuickTime
(*.mov)

H.264

 MPEG-4, AIC, MJPEG, ProRes,
Sorenson 1/3, PNG

 

QuickTime
(*.qt)

H.264, MPEG-4, AIC, MJPEG, ProRes,
Sorenson 1/3
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RM – RealMedia
(*.rm, *.rmvb)

Real Video 2/3/4, Cooker  

WebM
(*.webm)

VP8

 VP7, VP9  

WMV – Windows Media Video
(*.wmv)

WMV V8

 WMV V7, WMV9, WMV 9 Screen,
WMV 9 Advanced profile, MPEG-4,
WMV 9.1 Image V2

 

WTV – Windows Recorded TV Show
(*.wtv)

H.264, MPEG-2  

Audio formats

AAC – Advanced Audio Codec
(*.aac)

AAC

AIFF – Audio Interchange File Format
(*.aif, *aiff)

Uncompressed  

APE – Monkey's Audio
(*.ape)

Monkey's Audio  

AU
(*.au, *.snd)

PCM  

FLAC – Free Lossless Audio Codec
(*.flac)

FLAC

MP3 – MPEG-1/2 Audio Layer III
(*.mp3)

MP3

MPEG-4
(*.m4a)

AAC

OGG – Ogg Audio
(*.ogg)

Vorbis

WAV – Waveform Audio File Format
(*.wav)

PCM

 AAC, MP3  

WMA – Windows Media Audio
(*.wma)

WMA 9

 WMA Pro, WMA Voice  

Image formats

BMP, DPX, GIF, JPEG, PGM, PBM, PPM, PAM, PCX, PNG, PTX, TARGA, XBM,
XWD
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Codec activation
Some video and audio codecs are patented by other companies, and it is required that new users activate the codecs they use to comply with patent law.
 
Activate codecs on demand
1. When you open a media file or export your project with one of these codecs, you may see a Codec Activation message.
 
2. Select the Activate other codecs without asking box to activate all codecs automatically in the future. The codecs will be activated automatically, but
an Internet connection is still necessary.
 
3. Click Activate to complete the codec activation.
 
Codec could not be activated
If you see a codec activation error, make sure that you have a working Internet connection. Without Internet, the codecs cannot be activated even if you've
chosen to activate them automatically. After you've restored the network connection, please restart the application.
 
What kind of data is being sent?
The data we send does not contain any information that can personally identify you. We only receive information about which codecs were used.
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Updating the graphics card driver
If you encounter an error message asking you to update your graphics drivers, you will need to download a new driver from your graphics card
manufacturer's website and install it on your system. Some graphics card drivers also have a useful utility that notifies you when a driver update is
available and updates the driver automatically. Keeping your graphics card drivers up-to-date will ensure stable performance of applications and games on
your computer.
 
Step 1: Find your graphics card manufacturer
1. Right-click your desktop and choose Screen Resolution
2. In the Screen Resolution settings window, click Advanced settings.
3. This will open your graphics card properties. At the top of the window, your graphics card model will be listed under the Adapter Type section. Note
the full name of the graphics card somewhere for later.
 
Step 2: Download the new version
Now that you've learned your graphics card manufacturer and model, go to the manufacturer's website and find driver downloads. There, look for the
model or series that you've found earlier and download the driver installation file. Some manufacturers may also offer a utility that will automatically find
the necessary driver.
NVIDIA download center
AMD download center
Intel download center
 

Warning:
Only download drivers from the official manufacturer's website. Third-party websites offering driver downloads may contain malware.

 
Step 3: Install driver
Once the file is completely downloaded, run the installation file and follow the onscreen instructions to install the driver on your system. Your display may
blink several times in the process. After the installation has finished, it is advised that you restart the computer.
 

 
Updating NVIDIA® Driver
Modern NVIDIA graphics cards come with a special application called NVIDIA GeForce™ Experience that monitors driver updates and allows you to
optimize your computer's graphics performance.
 
1. Open the NVIDIA GeForce Experience application. It should already be installed on your system. If you cannot find the application, please try the
method above.
NVIDIA download center
 
2. In the Drivers section, click the Check for updates button to find the latest drivers.
 
3. When the application has found a newer driver, click the Download driver button. From here, the software will automatically download and install the
necessary driver for your system.

Updating AMD® or ATI® Driver
1. If you have an AMD or ATI graphics card, go to the Driver Download Center on AMD's official website.
AMD Driver Download Center
 
2. Download the auto detect utility and run it when the download has finished. 
Auto Detect Utility
 
3. The utility will then automatically find your graphics card and help you download and install the right driver for your system.
 
If the utility fails to find a driver for you, you can manually select your graphics card model and operating system on the Driver Downloads page and
download the driver.
 
4. After the driver has downloaded, run the installation file and follow the on-screen instructions to install it.
 
5. After the driver has been installed, it is recommended that you restart your computer.

http://www.nvidia.com/Download/index.aspx?lang=en-us
http://support.amd.com/en-us/download
https://downloadcenter.intel.com/
http://www.nvidia.com/Download/index.aspx?lang=en-us
http://support.amd.com/en-us/download
http://www2.ati.com/drivers/auto/autodetectutility.exe
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If none of the above steps have helped, feel free to contact our support team via e-mail or live chat.
 
If possible, please include the name of your graphics card model (see Step 1), as well as screenshots of any error messages you have encountered. This will
help our support team specialists solve your problem quicker.
 
 

mailto:support@movavi.com
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OpenGL troubleshooting
If you see the following message about OpenGL when you open Movavi Screen Capture Studio or you've noticed that the player, filters, or transitions do
not work, your computer most likely does not support the necessary version of OpenGL. To run Movavi Screen Capture Studio, your computer needs to
support at least OpenGL version 2.0, and version 2.1 is required for smooth performance.

OpenGL is a software interface that manages graphics output. Usually, OpenGL is handled by your graphics card driver. However, some graphics cards do
not support the necessary version of OpenGL. For these graphics cards, you can try the steps below:
 
Step 1: Update your graphics card driver
Sometimes, this issue may occur when something is wrong with the graphics card drivers or they are out of date. Download the driver installation file from
the manufacturer's website and install it following the on-screen instructions.
Detailed instructions on updating the driver
 
It is recommended that you restart the computer after installing driver software. After that, try starting Movavi Screen Capture Studio. If you see an error
message again, proceed to the next step.
 
Step 2: Try the software OpenGL implementation
If your graphics card still doesn't support OpenGL 2.1 even after updating the driver, you can use a software alternative:
 
•  In the message you see after starting Movavi Screen Capture Studio, select the Download and install software OpenGL implementation box.
 
•  Open the Settings menu and choose Preferences. There, select the Use software OpenGL implementation option and click OK.

After that, the software OpenGL package will be automatically downloaded and installed. When the installation is finished, restart Movavi Screen Capture
Studio.
 
If these steps haven't helped:
•  Check that your computer meets the minimum system requirements. Your graphics card must support at least OpenGL 2.0.
•  Contact our support team. Provide your graphics card model and list the steps you've taken to solve the problem. 

https://www.movavi.com/support/contact.html
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How to collect logs
Providing your log files when you contact support can help us solve your problem faster. The logs contain the program's actions for some period of time, as
well as important error reports and descriptions. The log files do not contain any personal information.
 
Note that extended logs give the most amount of information which may be essential to solving your problem. To save extended log files, go to General
Preferences and check 'Save extended logs for troubleshooting'.

Step 1: Show hidden folders
1. Open the Control Panel and switch to Small icons view.
2. Click Folder Options.
3. Switch to the View tab
4. Under Hidden files and folders, choose Show hidden files, folders, and drives.
5. Click OK.
Detailed instructions
 
Step 2: Open the Logs folder
1. Go to your system drive (usually Local Disk C).
2. Open the Users folder.
3. Open the folder with your username.
4. There, open the AppData hidden folder.
5. From there, go to Local > Movavi > Logs.
 
Advanced: you can also simply enter the following into Windows Explorer's path bar at the top: "C:\Users\USERNAME\AppData\Local\Movavi\Logs",
where USERNAME should be your user folder.
Note that the path may vary depending on your Windows version.
 
Step 3: Send us the logs
1. Find the folder named Screen Capture Studio 9.
2. Archive this folder and attach this archive to your e-mail, support chat or contact form when you describe your problem.

https://support.microsoft.com/en-us/help/14201/windows-show-hidden-files
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How to find system information
How to find your operating system version
1. Right-click your Computer icon.
2. Choose Properties from the pop-up menu.
3. In the System window, note the Windows edition and System type:

 
How to find your graphics card information
1. Right-click your desktop and choose Screen Resolution
2. In the Screen Resolution settings window, click Advanced settings.
3. This will open your graphics card properties. At the top of the window, your graphics card model will be listed under the Adapter Type section. Note
the full name of the graphics card.
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